
50
P
H
O
TO

P
R
O
JEC

TS
S
IM

P
LE

S
T
E
P
S
TO

B
E
T
T
E
R
P
IC
T
U
R
ES

U
S
IN

G
YO

U
R
D
S
LR

O
R
C
S
C 50

PHOTO
PR0JECTS

50
P
H
O
TO

P
R
O
JEC

TS
S
IM

P
LE

S
T
E
P
S
TO

B
E
T
T
E
R
P
IC
T
U
R
ES

U
S
IN

G
YO

U
R
D
S
LR

O
R
C
S
C

S
IM

P
LE

S
T
E
P
S
TO

B
E
T
T
E
R
P
IC
T
U
R
ES

U
S
IN

G
YO

U
R
D
S
LR

O
R
C
S
C

S
IM

P
LE

S
T
E
P
S
TO

B
E
T
T
E
R
P
IC
T
U
R
ES

U
S
IN

G
YO

U
R
D
S
LR

O
R
C
S
C

S
IM

P
LE

S
T
E
P
S
TO

B
E
T
T
E
R
P
IC
T
U
R
ES

U
S
IN

G
YO

U
R
D
S
LR

O
R
C
S
C 50505050

PHOTO
PR0JECTS

50
PHOTO

PR0JECTS

OUTDOOR INDOOR LIGHTING CREATIVE PHOTOSHOP

PR0JECTSPR0JECTSPR0JECTS
SIMPLESTEPSTOBETTERPICTURES!

LEARN NEW

PHOTO SKILLS

AND SH0OT
AMAZING

IMAGES ON YOUR

DSLR & CSC!





Welcome...
“Digital photography has made it far easier for more people to take
better quality pictures. The advent of affordable and highly versatile
digital SLRs and Compact System Cameras offers the winning
combination of high-resolution sensors and interchangeable lenses,
allowing photographers more versatility and quality than ever before.
However, while the latest technology helps make the actual capture of
images easier than ever, it can’t offer you ideas and inspiration on what

to photograph. While being technically proficient is important, it’s nothing without
creativity and the ability to turn your skills and imagination into great images. The
easiest way to do his is to try out a variety of techniques, learn from your mistakes
and build on your successes. Our 50 Photo Projects guide has been produced for
photographers looking to test their skills shooting a variety of subjects with the aim
of producing brilliant images. All 50 of our projects have been designed as step-
by-step guides to make them easy to follow and as you’ll discover, you don’t need
expensive equipment to shoot stunning images like those produced in this guide.
With themes covering Outdoor, Indoor, Lighting and Creative, you’ve no shortage
of photo techniques to try and we’ve also a selection of Photoshop tutorials to help
you create great images in post-production too. We hope 50 Photo Projects proves
exciting and inspirational and helps improve your photography. All the best!”
Daniel lezano, eDitor

All our experts are team members or regular contributors to Digital SLR Photographymagazine.
For more expert advice and inspiration, pick up the latest issue available on the second Tuesday
of every month. For further information visit the magazine’s website at www.digitalslrphoto.com

Meet ourteamofexperts

Daniellezano
Editor Lezano is passionate
about photography and an
author of several books. He
has been taking pictures for over
25 years and particularly enjoys
shooting portraits and still-lifes.

carolinewilkinson
An avid enthusiast photographer
for several years, Caroline uses
her in-depth knowledge of
Photoshop and creative skills in
post-production to add extra
impact and polish to pictures.

leefrost
A professional photographer
and writer for over two decades,
with 20 books to his name, Lee
is one of the best-known names
in the UK photography business.
www.leefrost.co.uk

rosshoDDinott
A regular contributor to
Digital SLR Photography,
Ross is an award-winning nature
photographer, specialising in
nature andmacro photography.
www.rosshoddinott.co.uk
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Create'mistywater'seascapes
MARKBAUER:Coastal landscapesareamongthemostpopular
subjectsforphotographersandit’seasytoseewhy.However, translating
thatatmosphereintoagoodphotographcanbechallenging.Onewayto
addmoodandcreateanethereal lookistousealongexposuretoblur

water.There’s no ideal shutter speed, as it depends on personal taste as
well as the size and speed of the waves, but the longer the exposure, the
more the water will smooth out, until you reach a point where it appears
to be completely still. I like to have some sense ofmovement in the scene,
but howmuch depends on the conditions and the composition. Keeping
things simple often works best, with just a single, strong element in the
foregroundwith plenty of space around it to show themovement of the
water. Once you have a composition that works, it’s best to stick with it and
keep shooting as the light changes so you get a nice variety of shots.

TIMEREQUIRED
45MINUTES
EQUIPMENT NEEDED
CANON EOS 5DMKII
24-105MM F/4 LENS
TRIPOD, LEE 1.2ND
(FOUR-STOP) FILTER,
LEE 0.9ND (THREE-STOP)
GRAD& REMOTE RELEASE
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1Conditions were perfect, as low tide coincided with sunset, and had
revealed a number of interesting rocks on the foreshore. I decided to

include this one in the foreground, as it I liked its textural quality, and the
way the waves were washing around it. Unfortunately, a shutter speed of
1/4sec didn’t quite do the trick, as although the breaking wave has created
a nice pattern in the foreground, themiddle distance looks somewhat static
and, if I'm honest, this makes the shot look rather uninteresting.

2A slight change in composition placed the rock on an intersection of
thirds, while the change in anglemeant it was pointing into the picture,

towards the distant headland. The light had also changed for the better, with
the setting sun lighting the clouds from below. I needed to slow the exposure
down a little, so I fitted a four-stop ND filter, as well as a two-stop hard grad,
to stop the sky from overexposing. A shutter speed of six seconds created a
nice swirl around the foreground rock, but the wave is distracting.

SETTINGUP:When shooting near the shoreline, there is always the possibility
that awavemaywash around the tripod legs, causingmovement and ruining
the exposure. Jam the tripod legs as far as you can into the sand or shingle,
to keep everything as stable as possible. Once the camera is securely locked
onto the tripod, slip theND andNDgrad filters onto the holder.

CALCULATINGLONGEXPOSURES:
When shooting in low light, you’ll often
find that exposure times go beyond 30
seconds, the longest shutter speed on
most digital cameras. It’s tempting to
raise the ISO and use exposures of 30
seconds or less, but you’ll get better
results if you stick at the lowest ISO
rating and shoot longer exposures. To
do this, you need to switch to ‘Bulb’
mode). You can then lock the shutter
open for as long as you need to get the
correct exposure. To calculate exposure
in aperture-prioritymode, increase the
ISO until you get ameter reading. Then
use this towork out the shutter speed at
the lowest ISO rating. For example, if the
correct exposure is 30 seconds at f/11 at
ISO800, it will be 60 seconds at f/11 at
ISO400, 120 seconds at ISO 200 and
240 seconds at ISO 100. You also have
to take into account the fact that if you
are shooting at dusk, light levels will
drop during this four-minute exposure,
so youwill need to addmore time.
Don’t underestimate this – adding just
one stopwill take your exposure time
up to eightminutes in this example!
Obviously, the reverse applies if you
are shooting at dawn.

Techniquewatch

NDfilterND+NDgradfilter

TRIPOD:With long exposures, a tripod is essential. Not
just any tripod, but the sturdiest you can manage to
carry, as it has to remain rock steady during exposures
of up to several minutes. You’ll also need a remote
release. Without one, you will not be able to lock the
shutter open without moving the camera.
NEUTRALDENSITY (ND) FILTERS: These are
also useful and are not to be confused with ND
graduated filters. ND filters are ‘solid’ rather than
split into a dark half and clear half, allowing you
to extend shutter speeds by reducing the amount
of light entering the lens. They come in different
strengths – typically one, two and three stops –
although you can also get NDs of ten-stops or more!
I find these extreme filters less suitable for colour
work as they have quite strong colour casts.

Essentialkit
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3I decided to lengthen the exposure slightly, to further soften the
movement of the water, so I waited for the light levels to drop and took a

15 second exposure at f/11 (still using the four-stop ND). I also tweaked the
composition again, to leave a little more space to the left of the rock, to
include the swirl of the waves inmy shot. The longer exposure smooths out
the distracting wave in themiddle distance, but has caused a confusing
pattern of ‘wave trails’ to appear in the foreground.

4A fewminutes later, and the light levels had dropped again, so I increased
my exposure time to 30 seconds. When shooting in Raw format, I like to

exposemy shots 'to the right’. Thisminimises noise and capturesmore tonal
information, and as there’s space to the right of the histogram, I knew that there
was room to push the exposure further before the light faded completely. For
my final shot, I set the exposure for twominutes at f/11 – two stopsmore than
this shot, which would reduce the underexposure seen here.

Finalimage
The longer exposure has reduced
the wave trails in the foreground
and smoothed the water in the

middle distance and background
to reveal the reflections of the sky.

There is still some movement in the
foreground, and the wave patterns

around the rock are still visible.

Take care not to leave your tripod

unattended. The strongwinds and

swirling seas can easily knock it

over. Digital cameras and salt water

do not a happymarriagemake!

Stayclosetoyourkit!
tayclosetoyourkit!
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2Trees create a graphic, simple outline – perfect for silhouettes. It is easiest to
take silhouettes inmornings and evenings, when the sun is lower in the sky,

so I arrived atmy location early. Two trees together on a hillside caughtmy eye.
Using the long end of a standard zoom, I cropped in tightly to them, but the
camera’sMatrixmulti-zonemeter attempted to record themas amid-tone,
resulting in a disappointing, washed-out shot.

3To ensure that the lovely colours of the sunrisewere recorded faithfully, and
that the treeswere thrown into pure silhouette, I switched the camera's

meteringmode to 'spot' (This is often illustrated by a dot, as seen in the picture
above). OnmyNikonD300, I selected thismode by turning a dial, just above the
monitor. If you are unsure how to select spotmetering, check the instruction
manual. If your camera lacks a spotmode, use partialmetering instead.

1When shooting silhouettes, a low viewpoint oftenworks best – helping you to
set your subject starkly against a bright sky. Therefore, don’t be afraid to get

your knees dampand dirty to select a low angle. In this instance, I splayed the
legs onmy tripodwide-open, enablingme to shoot froma lowperspective.

Shootsilhouettes
ROSSHODDINOTT:Asphotographers, we are always
striving for the ‘correct’ exposure, aren’t we?However,
it could be argued that there is no such thing; as it
greatly depends on the subject, the situation, and the

effect the photographerwants to achieve. For example, a
silhouette can create a truly eye-catching image even though,
technically-speaking, it is the result of a poor exposure…
Asilhouette iswhen the subject is recorded as a black

outline, without colour or detail, against a lighter background
– in otherwords, the subject is grossly underexposed. It is the
most extreme formof backlighting but, when combinedwith
the right scene or subject, the results can be stunning –
particularlywhen the subject is contrasted against an
interesting or colourful sky. Despite the lack of detail and
colour, silhouettes can conveymuch about the subject and they
prove that there really is no such thing as a ‘correct exposure’.
One of the great things about shooting silhouettes is that

they are easily achieved and youneed very little in termsof kit.
I visitedDartmoor’swindswept landscape to showyouhow to
shoot perfect silhouettes…

TIMEREQUIRED
30MINUTES
EQUIPMENT NEEDED
NIKOND300, 24-85MM
ZOOM LENS& TRIPOD
ALSO USED
SPOTMETERING & AE-L

METERING:Your camera’s
multi-zonemeter is designed to
render the subject as amid-tone.
Whilst this is perfect for the vast
majority of situations, itwill rarely
produce the results youare looking
forwhen shooting subjects that are
considerably lighter or darker in tone.
A silhouetted subject can create
problems formetering systems.
Althoughhighly sophisticated, the
camera’s exposure systemcannot
predict the effect youare trying to
achieve. Therefore, if the scene is
dominatedbyablack, silhouetted
subject, the camerawill attempt to
render it as amid-toneby selecting a
longer exposure– resulting in
overexposure. Alternatively, if the
scene is dominatedby sky and is very
light, the camera is likely to
underexpose the frame. Thankfully,
avoiding this typeof exposure
problem is simpleby switching your
camera’s spotmeteringmode. This
meteringmode is selected either via
adedicatedbutton, or through the
camera’smenusystem. It calculates
theoverall exposure from just a small
portionof the frame–usually a
central circle. Point the spotmetering
circle at abright areaof the frame
andpress the shutter releasebutton
halfway to take a reading. Theseare
the exposure settings youwant to
employ to take your silhouette.
Pressing the auto- exposure lock
(AE-L) button, ‘lock’ the settings,
compose your imageand release the
shutter. The result shouldbe that your
subject is underexposedandappears
as apureblack silhouette.

Techniquewatch

In silhouettes, we strive for themain

subject to be devoid of detail or colour;

so select subjects with a strong,

recognisable outline. People, buildings,

animals and treesmake good choices

Seekastrongoutline!
eekastrongoutline!
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Finalimage
By zooming in a little from the last frame, I feel that

I’ve struck the right balance in terms of composition.
Placing the trees right-of-centre creates a stronger
image than it would have if they had been central.
Spotmetering has enabledme to capture the right
exposure in-camera – all I had to do post-capture

was intensify the sky’s colour very slightly by
clicking Image>Adjustments>Hue/Saturation

and adjusting the saturation slider to +10.

4I removed the camera from the tripod, via the quick release plate, and then
pointed the spot-metering circle at a bright area of the sky. I pressed the

shutter release button halfway down, to takemy spotmeter reading, and then
locked these settings by using the auto-exposure lock (AE-L) button.
I replaced the camera on the tripod and quickly checked that the composition
hadn't changed. Then, using the new, locked settings, I took another picture.

5Although the exposurewas now correct, I was feeling less happywith the
composition. It looked a little cramped and Iwonderedwhether I had cropped

in too close to trees. The joy of using a zoom lens is being able to quickly change
compositionwithout even having tomove. I zoomed out to leavemore space
around the trees, allowingme to capturemore of the sunrise. However, had I now
gone too far toward the opposite extreme?
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TIMEREQUIRED
ONEHOUR
TIMEREQUIRED
ONEHOUR
EQUIPMENT USED
CANON EOS 5D
17-40MM F/4 LENS
TRIPOD& REMOTE

EQUIPMENT USED
CANON EOS 5D
17-40MM F/4 LENS

ALSO USED
ADOBE PHOTOSHOP
ALSO USED
ADOBE PHOTOSHOP

Shootingstars
JOHNPATRICK:Star trails are rewarding subjects that can add an element
ofmagic to a landscape shot, revealing the scene in away that isn’t visible to
the eye. They allow you to extend the day’s potential shooting time, and to
get outwith your camera – especially if youwork through theweek and can’t

get outdoors during the daylight hours inwinter. If there’s any ‘secret’ to the technique,
it’s getting the exposure right, but that’s simplewhen shooting digitally...
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STURDYTRIPODANDAREMOTERELEASE
You'll need to keep the shutter open for the longexposure
and thebestway todo that is to use a remote releasewith a
lock tohold the shutter open. This helps avoid inadvertently
knockingormoving the camera. A sturdy tripod is important
too andawide-angle lens is handyas it helps youget plenty
of sky in the shot.Other than that, star trails don't needany
particularly specialist kit. Don't forget plenty ofwarm
clothing though. Even if you're used tobeingout in cold
weather, standingaround for half anhour ormore in thedark
in sub-zero temperatures canbring awhole new level of
chilliness, sopack a fewextra layers to keepyoucomfortable.

3USEYOURCAMERATOMETERTHE
SCENEYoucanmeter the scene

before taking thefinal shot by taking
test shots at a high ISOandwide
aperture. I'musing ISO 1600and f/4
here. Set the camera tomanual and
startwith an exposure timeof around
20seconds. Take a shot and check the
histogram, then simply alter the
exposure timeand re-take test shots
until the histogram looks correct. After
a bit of experimentation I find that one
stopunderexposedworks best.

2SETTINGUPPick your night (a
nightwith a half-moon is a good

choice if possible) and set up the
camera on the tripod. If it's too dark
to seeproperly through the viewfinder,
you can take a fewshotswith a high
ISOandwide aperture, gradually
making adjustments tofine-tune the
composition. Autofocus is unlikely to
work in very low light, so you'll need to
focusmanually – either by using the
distance scale or byplacing a torch
somewhere in the scene to focus on.

1FINDTHELOCATION If you can, it helps tofind your location in advance, in
the daylight hours.Mid-day is a good time to do this for a couple of reasons.

One is that it's often dead-time in the landscapephotographer's daywhen the
light is too harsh for shooting. Theother is that,with the sun to the south,
shadowswill point north towardswhere the starswill be circling roundPolaris
later. Pre-visualising thatwill help you create a good composition. You'll need to
ensure that you're a decentway frommajor light pollution too.

The glow fromurban areas is known as

light pollution and can be seen from

miles away on a clear night. Thismight

not be obvious to the naked eye but will

show up clearly on a long exposure

Getoutofthecity
Getoutofthecity

Essentialkit
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4SETTINGSFORTHEFINALSHOTWhenyou're happywith the exposure, set
the camera to 'Bulb'. Select ISO 100and set awide-ish aperture. I tend to

use f/5.6.Nowyou canuse the exposure time fromstep3 towork out the time
needed for thefinal shot, compensating for the change in ISOandaperture by
increasing the time. For instance, if youneededa30secondexposure in step3:
30secs x2 (for a one-stop change from f/4 to f/5.6) x 16 (for the change from
ISO1600 to ISO 100) gives a 16-minute exposure.

5TAKETHESHOTTurn all lights out, note the timeand lock the shutter open
with the remote release.Get out somecoffee and chocolate, have abreak for

awhile andenjoy staring at the stars. Just don't dowhat I did anddiscover at this
point that the coffee's backdown the road, still in the car! If youneed to put a
light on at anypoint to read the time, be careful not to illuminate the foreground
at all, as itwill showup in thefinal shot (unless you're deliberately attempting
light painting, but that's another topic).

Finalimage
I've given the final image a little

bit of curves adjustment, a
colour balance on the cool side
of daylight and applied some
UnsharpMask in Photoshop.
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1CHOOSEYOURDAY:Fog andmist are formedwhenmild,moist air passes
over cold ground – the lower layers of the air get cooled down rapidly to

the temperature at which fog ormist forms. Keep an eye on the forecast and
look out for cold, clear nights with a light south-westerly wind, as this gives a
high chance ofmist or fog. Even if the conditions seem right, however, an
atmospheric sunrise isn't guaranteed – often, for example, you can get a thick
fog rather thanmist – so persistence is important. Be prepared tomake
multiple visits to your favourite locations.

2BEWELLPREPARED:Mist often forms at the bottomof valleys, where the
ground is colder, so the hills above a valley are a good place to be, as this

enables you to shoot fromabove a layer ofmist, with hills rising out of it. Being
nearwater also helps, as this helps to cool any airmoving over it. Research
suitable locationswell in advance and arrive a good half an hour before sunrise,
as the pre-dawn light can bemagical. For this shoot, I set up overlooking thewest
WiltshireDowns, withmist lying at the bottomof the hills. Also, be sure towrap
upwarm–gloves, a hat and a thick fleece are essential!

Shootamistylandscape
MARKBAUER:Latewinter/early spring is an excellent
time for shooting atmospheric landscapes, especially if
you're prepared to get up early. As one season slips into
another, it often brings interestingweatherwith it, and

at this timeof year,mistymornings are common, often combined
with a touch of frost. Foggy scenes convey a sense of romance
andmystery, and add an element that can lift otherwise bland
scenes out of the ordinary.With the right technique and careful
planning, it's possible to capture dramatic, atmospheric scenics.

TIMEREQUIRED
1-2 HOURS
EQUIPMENT NEEDED
CANON EOS-1DSMKII
70-200MM LENS
MANFROTTO TRIPOD
ALSO USED
REMOTE RELEASE

KITFORMIST:
Usinga tripod is goodpractice
for shooting landscapes, but
essential if you’re headingout
for pre-dawnmisty pictures,
as exposures canbe long.
Amedium telezoom isprobably
themost useful lens as its focal
length compressesperspective
andenhances themisty effect.
A set ofNeutralDensity
graduatedfilterswill be
necessary in pre-dawnshots,
as the skywill bemuchbrighter
than the land,whichhasno
direct light falling on it.

Essentialkit

✘Normalexposure:Themeter
will assume that whatever it's
reading from is amid-tone, and
underexpose themist so that it
records as grey rather thanwhite.

✔Expose‘totheright’:Around +1
stop compensationwould be enough
to keep themist lookingwhite.
I’ve added a littlemore, following
the ‘expose to the right’ theory.

PERFECTMETERING:Mist and fog tend to fool the camera into
underexposure, so be prepared to add at least a stop over themetered
reading using exposure compensation. If shooting Raw, you’ll record the
maximumamount of tonal information by exposing ‘to the right’ (pushing
the exposure as far into the highlights as you canwithout actually ‘clipping’
the highlights.) You’ll need to do somework in the Raw converter on
exposure, brightness and contrast, but the end result will be a better image.

Techniquewatch
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3CHECKYOURCOMPOSITION:You need to look for strong, bold shapes, as
mist hides shapes and dilutes colours,making a scenemonochrome. I like to

look for overlapping and interlocking shapes that help add a sense of depth to
the scene. Backlit scenes can alsoworkwell, as the shapes of hills are
silhouetted in themist. Flare isn't toomuch of a problemwith backlit shots, as
themist diffuses the sunlight. For this shot, I selected a hill rising out of themist
as themain focal point, and arranged it according to the rule-of-thirds. Behind
the foreground hill, the layering effect leads the eye into the backdrop.

Finalimage
I zoomed in slightly frommy initial composition, to

remove the slightly distracting band of colour at the
top of the frame and keep the shot asmonochromatic
as possible. I used a daylightWhiteBalance preset to
keep the pre-dawn colours cool, and added a touch of

vibrance to enhance the blue tones. Keep shooting
as themist swirls around and the light changes.

What’s the difference betweenmist and

fog?We’re happy to provide the clearest

of answers – they’re basically the same!

The only difference is one of density –

if visibility is less than 1,000m, it’s fog!

Mistorfog?
Mistorfog?

4EXPOSURE&FILTRATION:Mist can fool themeter into underexposure, so as
a starting point, set +1 stop exposure compensation.Meter from the land

and the sky to check the difference in brightness, to see if you need a graduated
filter and, if so, which strength. Take care not to over-filter the scene (e.g. if
there's a four-stop difference in brightness, use a three-stop grad so that the sky
remains a little lighter than the land and therefore looks natural). For these
shots, I used a one-stop soft grad as, although therewasn't a huge range of
contrast, I felt that the sky needed a little bit of help to add interest.
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3The streaking is created bymoving the camera during exposure, so the
shutter speed you use is important. Anything between 0.5secs to two

seconds is ideal. To set this, I set the camera to aperture-prioritymode and stop
the lens down to f/16 or f/22. In low light, such a small aperturemay not be
necessary, while in bright conditions I often need a Neutral Density filter.

1First findasuitable location. I liveby theseaand favour coastal viewsbecause therearedefined linesof colour in thescene,
createdby thebeach, then thesea, then thesky.However, anyscenecontainingbandsof colour is suitable. In thespring, fields

of yellowoilseed rapeagainst blue skywouldworkbrilliantly. Thesamegoes forpoppyfields in summer.Urbanscenesatnight are
wortha try too, as thecolourful lightswill recordas streaks.The important thing is that youhaveclearlydefinedareasof colour that
arewideenough to formstripsacrossyour shot.Remember though, that this is anexperimentandbreaking the rules is allowed!

2 If you want the lines and streaks in the image to be straight (or as straight
as possible), you need tomake sure the camera is level and that it remains

level when you pan across during the exposure. I do this by first using the
spirit level onmy tripod, and then using a second spirit level, mounted onmy
hotshoe, which helpsme to level the camera itself.

Createpoetryinmotion
LEE FROST: It’s funny howsomephotographic techniques comeabout purely by accident.
For example, it’s said that solarisationwas discoveredwhenAmerican photographer LeeMiller
(working asManRay’s assistant at the time), turned the darkroom light onwhile a printwas still
in the developer, causing a partial reversal of the image tones. I can’t claim thatmy latest

techniquewill achieve the same level of fameor popularity, but I discovered it under similar
circumstances, while taking pictures on theNorthumberland coast just beforeChristmas. I was planning
to shoot a sequence of images for a stitchedpanorama, so I levelled the camera and scanned the scene I
wanted to record. Confident that everythingwas ready, I tripped the shutter to expose the first framebut,
without thinking, I swung the camera to the right, ready to shoot the second framebefore the exposure
for the first had ended. Annoyedbymy impatience, I waited for the image to appear onmycamera’s
preview screen so I could erase it. Butwhen the imagedid appear, far frombeing a load of old rubbish, as
expected, it looked fantastic – an eye-catching abstract of coloured lines and streaks,more like a painting
than a photograph. Surprised bymyhappy accident, I decided to try and repeat the effect, but this time
doing it on purpose. Since then, I’ve produced awhole series of these images. Not only are they easy and
fun, but the results look fantastic. Here’s a step-by-step guide so you can try it yourself.

TIMEREQUIRED
TENMINUTES
EQUIPMENT NEEDED
CANONEOS-1DSMK III
CANON24-70MMF/2.8
0.6NDHARDGRAD&
FILTERHOLDER
TRIPOD&REMOTE

TRIPODHEAD:
If youwant toproduce
smooth, consistent results
using this technique, you
need the right typeof tripod
head. I’ve beenusing a
Manfrotto 410 Junior
gearedhead for thepast few
years. It is great for precise
adjustments, but not so
greatwhenyouwant to
makebigger, fluid
movements of the camera.
Fortunately, just before
Christmas I replaced the
gearedheadwith a
Manfrotto ball head,which
canbeunlockedon the
horizontal axis,making it
easy topan the camera
evenly. Pan& tilt heads are
evenbetter because they
havearms to adjust the
cameraoneachaxis, so you
can lock the forward/
backward tilt and the
vertical adjustment and
simplymove the cameraon
thehorizontal.

Essentialkit

Though this technique is all about
movement, it’s important that your
tripod is sturdy and locked off in all
directions, other than the pan –
otherwise you’ll just get a blurrymess

Steadyasyougo
Steadyasyougo
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5Back home, download the images to your computer. I shoot in Raw, so the
first step is to process them using Adobe Camera Raw. I usually find that

adjustments to Clarity and Vibrance add impact, along with Tone Curve to
boost contrast. Once opened in Photoshop, I select the sky, make further
adjustments to levels and curves, and then do the same to the foreground.

Finalimage
Thefinal stage, forme, is to crop the image to
a square. I feel that the square format adds to

the symmetry andmakes the compositionmore
balancedandordered.Byalwayskeeping the

horizoncentral, a consistent theme runs through
each image,making themworkwell together.

4Once you’re set up and ready, do a few practice runs without taking any
pictures. Hold the tripod head or adjustment arm, position the camera to

the left of the scene youwant to shoot, then smoothly pan from left to right.
When you’re happy you knowwhat you’re doing, try it for real. The results may
be a little jerky to begin with, but you’ll soon get the hang of it.



Shootsilh
ROSSHODDINOTT
striving for the ‘corr
it could be argued
greatly depends on

effect the photographerwan
silhouette can create a truly
technically-speaking, it is the
A silhouette iswhen the

outline, without colour or de
– in otherwords, the subject
most extreme formof backligh
the right scene or subject, the
particularlywhen the subject
interesting or colourful sky
colour, silhouettes can con
prove that there really is no
Oneof the great things about

they are easily achieved and
visitedDartmoor’swindsw
shoot perfect silhouettes…
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silhouettes
HODDINOTT:Asphotographers, we are always

the ‘correct’ exposure, aren’t we?However,
argued that there is no such thing; as it

depends on the subject, the situation, and the
apherwants to achieve. For example, a

a truly eye-catching image even though,
it is the result of a poor exposure…

when the subject is recorded as a black
olour or detail, against a lighter background

subject is grossly underexposed. It is the
backlighting but, when combinedwith

subject, the results can be stunning –
subject is contrasted against an

olourful sky. Despite the lack of detail and
an conveymuch about the subject and they

ally is no such thing as a ‘correct exposure’.
things about shooting silhouettes is that

ed and youneed very little in termsof kit. I
windswept landscape to showyouhow to
ttes…
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TIMEREQUIRED
30MINUTES
TIMEREQUIRED
30MINUTES
EQUIPMENT USED
NIKOND300,SIGMA
150MM,TRIPOD&
REMOTERELEASE

EQUIPMENT USED

150MM,TRIPOD&

ALSO USED
REFLECTOR
ALSO USED

Wildwebwonders
ROSSHODDINOTT:Rather than searching theweb for ideas, why not get outsidewith
your digital camera and search for a real web?Spiders spin beautiful cobwebs of sticky
silk, and their constructions are intricate, often symmetrical and look stunning close up.
Therefore, if you owna close-focusing zoom, close-up filter, extension tube or – better

still – a dedicatedmacro lens, youwill be able to capture stunning, frame-filling images.
Spiders live everywhere, so you shouldn’t struggle to find a suitableweb to photograph.

They're easiest to find– and look theirmost photogenic –when smothered in tinywater droplets.
Therefore, earlymorning after a clear, still night is the best time to look. Alternatively, you could
spray onewithwater to create a similar effect by using a gardener’s spray bottle to create a fine
mist thatwon’t damage theweb. In autumnandwinter, after a cold and frosty night, youmight
even find a frozenweb,which is particularly photogenic and canmake very arty, abstract-looking
images by using a shallowdepth-of-field, togetherwith careful focusing.
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1I didn’t have tosearch longbeforefindingadew-ladenweb. I composed the
imagequickly, including theentireweb in the frame. I setanapertureof f/8,

hoping that thiswouldcreatesufficientdepth-of-field tokeepthewebsharp,while
not recording toomuchbackgrounddetail.However, Ididn’tpayenoughattention to
thebackgroundandthewebdoesn’t standoutverywellagainst the lightbackdrop.

3 I wanted to create amore arty looking result. So, I selected a larger aperture
of f/4, and placedmy set-up at an angle to theweb. Thiswould allowme to

record just part of theweb in focus. Focusing needs to be accuratewhenworking
with such a shallowdepth-of-field. I checked the image on the LCDmonitor,
zooming in to check the subject's sharpness. Unfortunately,my focusing isn’t
precise enough and the image is soft.

2The subject’s backdrop is often amajor contributing factor to a photo’s
success or failure. By simply changing viewpoint, shooting angle, focal length

or aperture, you can alter the background’s colour and appearance. To eliminate
thewhite sky from the image-space, I selected a higher angle by extending the
legs ofmy tripod. A grassy bank now created amore attractive, green
background. I also opted for a tighter composition.

REFLECTOR:
Acompact,
fold-away
reflector is an
essential close-up
accessory. Theyare
designed tobounce
natural light onto
miniature subjects in order to
relieveugly shadows.A reflector
will normally create amore
natural-looking formof
illumination thanflash.
However, I haveoften employed
a reflector (or its black cover) as
amakeshift background for
small subjects to create a
simplebackdrop. In some
situations, you canevenusea
reflector’s silver orwhite side in
order to create high-key results.

Essentialkit

Be care
ful not t

o knock
theweb

, or any

grasses
itmight be

joined to (it’s e
asily

donew
ith a tripod

leg). If y
ou do, you

may dam
age the

web and knock t
he

photoge
nic drop

lets to t
he grou

nd

Handlewithcare!
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5Although happywith the previous shot, I felt a black backdropwould suit the
subject better – thinking it would contrast starklywith the glisteningwater

droplets. The cover ofmy foldaway reflector is black, so I held it around40cm
behind theweb and used the self-timer to trigger the shutter. Finally, I had the
result I wanted. If you’d prefer amore colourful look, you could try using
brightly-coloured card to alter the appearance of the background.

4 I tried again. Using a shallowdepth-of-field at this level ofmagnification
allows the photographer to precisely direct the viewer’s eye to a specific

point of focus. If your camera has a previewbutton, use it to review the
distribution of depth-of-field. This time I took an extra fewmoments to ensure
my focusingwas accurate and released the shutter remotely to prevent any
cameramovement spoiling the image.
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PAULWARD:Oneof themost stunning techniques on
which to practice your low-light photography skills is
the capturing of traffic trails. Not only are there an
abundance of vehicles on the road, but on dark

evenings from late autumn through to springtime, you can
venture out just after EastEnders to give this technique a go,
rather thanwaiting until the dead of night.
Images of traffic trails work by combining a long shutter

speedwith the fast-moving lights caused by cars passing through the frame. Because of the
low light and long exposure, the cars are invisible, leaving only the streaks of their headlights
in the shot. The technique requires the smallest amount of kit, whichmakes it evenmore
appealing. All you need is a digital camera and a tripod, although a remote release cable will
make the process a lot easier. Ready to give this technique a go, I grabbedmy gear and
headed out into the dark, taking a position on an overpass of a busy Birmingham road. I
recommend always arriving at your location at least tenminutes before the sun goes down so
you can take your time and find the best angle to shoot from, and also to take advantage of
the sky’s blue tint that’s visible directly after the sun goes down.
Because you’re shooting at night, it’s worth remembering a few important safety

precautions. Always have permission to photograph if you are snapping fromprivately owned
land. Remember to be as discreet as possible – you don’t want to advertise that expensive
camera body to thieves. Finally, because youwill be shooting in the vicinity ofmoving traffic
– itmay be an obvious one to consider – be aware of the cars around you. It may be awise
decision to wear a fluorescent bib, which can be bought from cycling shops such as Halfords.

WHITEBALANCE: If you shoot in Raw,
you can alter theWhite Balance in
post-production after you have uploaded
your images on to your computer. However,
if youwant to try differentWhite Balances
while taking your shot, there are a couple of
ways this can be achieved. Either take a test
shot, changing theWB in themenu as you
go, or switch to LiveView and use the LCD
monitor to judge how theWhite Balance
presets affect your image.

Techniquewatch
TIMEREQUIRED
30MINUTES
EQUIPMENT USED
CANONEOS-1DSMkIII
WITHCANON
17-40MMF/4LZOOM
&TRIPOD

1 I set upmy tripod to take a few quick test shots at a high ISO, to see how
the angles and lights look, before returning the ISO to 100 and placing the

camera on the tripod. I choose to shoot the image in portrait format to
emphasise the long winding streaks caused by the headlights, and also to
include the tall buildings bordering the road.

3 I attempt to take another shot with a longer shutter speed. However, as I
trigger the shutter button, my hand causes some vibration to the camera,

blurring the image. To get around this problem, I attachmy remote release,
although if you don’t have one, you can simply set your camera’s self-timer.
Remember not to knock the tripod during the exposure.

2 I set the cameramode tomanual. You can use aperture-prioritymode, but
the streetlights can trick the camera’smetering system.My exposure of

1/10sec at f/2.8 (ISO 100) isn’t long enough to create any
traffic trails. Also, the wide aperturemakes the streetlights look bland – using
a smaller aperture will give the lights a pleasant starburst effect.

4I play aroundwith some different shutter speeds to see how they affect the
image. At ten seconds the image is too dark, losing detail in the road.

However, at 16 seconds the image is too light, with the light trails burning out.
A shutter speed between these two points should giveme the correct exposure.
You should experiment with your shutter speeds, too.

Shootingtraffictrails

Ten secondsatf/18

1/10secatf/2.8

30secondsatf/18

Tungstensetting

Flashsetting
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Finalimage
Withexposure settings correct,

everything falls intoplace to
produceadynamic image.Why
not give this techniquea shot?
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Close-ups of butterflies
ROSSHODDINOTT:Summerwouldn’t becomplete
without thegraceful flight andvibrant coloursofbutterflies.
Theycanbe found inflower-richmeadowland, along the
coastline, inwoodedgladesand inourgardens.Although

wildlifephotographycanbe trickyand frustrating, butterfliesareeasy
to locateandget close to, particularlywhen feeding. Larger species
areofteneasier tophotograph, asyoudon't need toget soclose to
themtoachieve frame-filling shots.Small Tortoiseshell, Peacockand
RedAdmiral butterfliesareperfect forhoningyour skills. They're
largeandcommon, andwill oftensettle onflowersorbask
open-wingedonwalls longenough for you to shoot them.
Insectsarehighly sensitive tomovement, somoveslowlyanddon't

makeanysuddenor jerkymovements. I recommendusingmanual
focus, as it is quieter. Youalsoavoid the riskof 'hunting' as the lens
tries to focus,whichwastes valuable time.Macro lensesarebest for
this typeofphotography, providingexcellent imagequality anda
goodworkingdistance.However, cheaperalternatives suchas
extension tubesor close-upfilterswill alsoget the jobdone.
Mostpeople shootbutterflies fromoverhead,with theirwingsopen

flat; but to create striking, less conventional images, experimentwith
other anglesanddepth-of-field. Try shooting themfromeye-level or
backlit to show the transparencyandmarkingsof theirwings.
Togiveyoua few ideas, I recently visitedsomenearbygardens

where therewereseveralmigrantPaintedLadybutterflies.All that's
requirednow isa littlepatienceand luck.

TIMEREQUIRED
60MINUTES
EQUIPMENT NEEDED
NIKOND300 & 105MM
MACRO LENS



1NOTCLOSEENOUGH: I began by simplywatching the butterflies for a few
minutes, observing their habits andwhich plants they preferred. TheRed

Valerianwas a clear favourite, so I stood nearby, camera at the ready. As the
butterfly lands, approach it slowly, graduallymoving the camera to your eye.
Older insects can look tatty, with faded colours, so only snap butterflies in
pristine condition.Myfirst effortswere disappointing, as I shot from too far
away, so the butterfly is not large enough in the frame. I needed to get closer.

2BEAWAREOFYOURBACKGROUND:Be aware ofwhat is going on behind
your subject, as amessy backdropwill ruin your image.With practice, it

becomes easier to let your eyewander around the framewhile you focus and
compose your shot. A small change in shooting position can eliminate distracting
foliage from the frame. Alternatively, awider aperturewill throw the background
out of focus. However, sometimes, there is nothing you can do other thanwait
until the butterflymoves to amore photogenic position.

GETTING PREPARED: When ‘stalking’ butterflies, you have no option but to keep your set-up
simple. A tripod often proves impractical – being too fiddly and time-consuming to position, and
greatly increasing the risk of disturbing your subject. However, presuming it's a fine, sunny day,
there should be sufficient light to enable you to select a shutter speed upwards of 1/200sec
– fast enough to freeze subject and camera movement. When working handheld, keep your
elbows pushed in towards your chest to limit camera shake. If you do require the added stability
of a support, consider using a monopod, which is easier to position and shouldn’t disturb the
surrounding plants. Butterflies rarely feed or rest for long, so you will need to focus and compose
your image quickly – something that gets easier with practice.

Aperture-prioritymode allows you
control over depth-of-field, whilst the
camera sets the corresponding shutter
speed to ensure you canwork quickly
andwith theminimumof fuss

Shootingmodegm

MACROLENS:
It isn’t really fair to
suggest that amacro
lens is an ‘essential’
piece of kit when
photographing
butterflies. Budget
alternatives, like close-up
filters, are capable of very
good results. Also,many
modern zooms offer a
‘macro’ facility, which
provides a highly useful
reproduction ratio of up
to 1:2 (half life-size),
which is good enough to
fill the framewith larger
species. However, a
dedicatedmacro is the
best choice for wildlife
close-ups. For flighty
insects, a ‘tele-macro’,
such as a 90mmor
100mm, is a good choice.
Not only do they offer
superb image quality up
to 1:1 (life-size), but this
type of focal length
creates amore practical
camera-to-subject
working distance,
minimising the risk of
disturbance and,
therefore,maximising
the photographer’s
chances of success.
Amacro of this length is
also relatively compact
and lightweight, making
sharp results possible
when handheld – even
without image-stabilising
technology.

Essentialkit
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3DEPTH-OF-FIELD:This is crucial in close-up photography. Toomuch, and
background detail will be too defined. Too little and the subjectwon't be

sharp throughout. A good general rule is to set thewidest aperture thatwill still
keep your subject acceptably sharp. This also ensures that the shutter speed is
fast enough to freeze subject and cameramovement. In this instance, after
reviewing a handful of test frames, I found that f/7.1 generated sufficient
depth-of-field, whilst throwing the vegetation behind pleasantly out of focus.

4SHOOTINGANGLE:Generally, if a butterfly is resting or feedingwith its
wings open flat, photograph it fromabove. If its wings are closed, shoot from

one side. Regardless ofwhether thewings are open or closed, try and keep your
camera parallel – if not, its wingswill begin drifting out of focus. However,
remember that you don’t always have to opt for conventional angles. Try
shooting straight on at eye-level or froma low viewpoint, for instance.With this
shot, I combined the two approaches to create amore original-looking result.

Finalimage
Photographing butterflies is a challenge,
as just as you're about to get theperfect
shot, they fly away! After nearly an hour

of chasing butterflies around, I only
managed a handful of images Iwas

genuinely pleasedwith. Persevere and
your patience should be rewarded too.
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POLARISER:A polarising filter is designed to block light polarised in one
plane. By doing so, it can reduce or eliminate reflections and enhance
contrast. They are constructed from a thin foil of polarising material,
mounted between two circular pieces of glass. By rotating the filter in
its mount, you can alter the filter’s angle of polarisation and the degree
of polarised light that can reach the image sensor. Using a polariser is
intuitive – simply look through the viewfinder and rotate the filter until
you get your desired effect. Polarisers are one of the most useful filter
types and their effect can’t be replicated on your computer later. Although
designed to reduce reflections, applied correctly, they can also enhance
them. By removing the reflective film or sheen on the water’s surface, the
colours of reflections will be intensified. Apply the effect with care though
– the filter will diminish the reflections if you’re not careful!

1POLARISATION: The effect of a polariser has to be seen to be appreciated.
It can radically alter a scene’s appearance, andwhile it can eliminate or

reduce reflections, it can also enhance themby removing the reflective sheen
from thewater’s surface. To ensure you achieve the right effect, slowly rotate
the filterwhile looking through the viewfinder. You'll see the reflections fade
and intensify. Stop at the pointwhere the reflections look strongest.
These two images help to illustrate the contrasting effects of the filter.

2SHUTTERSPEED: Shutter speed is a key considerationwhen shooting
abstract reflections. Too slow and the rippleswill blur, which is normally

undesirable, as the reflections – and the beautiful, swirly pattern they create –
won’t be sowell defined. A good general rule is to shoot upwards of 1/250sec.
Don’t worry if you need to select a large aperture to do this – often the narrow
depth-of-field this createswill only add to the ‘arty’ effect. However, this is
subjective, so experimentwith the shutter speed until you like the effect.

Nopolariser Withpolariser 1/250sec1/30sec

Essentialkit

Shootabstractreflectionsinwater
ROSSHODDINOTT:
Reflections can be
irresistible to
photographers. A still
body of water acts as a

mirror, perfectly reflecting its
surroundings. Landscape
photographers often use reflections
to create symmetry, but water
doesn’t need to be still for
reflections to be photogenic. A slight
breeze will create gentle ripples in
smooth water, distorting the colour
and appearance of reflected
subjects. Mundane subjects can be
distorted to the point of abstraction,
such as a block of flats, a boat’s
mast or a brightly coloured buoy. By
excluding the subject and isolating
the reflections, it’s easy to take
some unusual, arty images.When photographing water andmovement, each
shot is unique, with the look of the rippled water constantly changing. In order
to isolate the reflections, a telezoom is a good lens choice. A 70-300mm lens
is ideal, as its focal length rangewill allow you to achieve a variety of different
results. Shutter speed is a key consideration – too slow and the water will blur.
For crisp reflections, a speed upwards of 1/250sec is often required. As a
result, you can normally work handheld without any great risk of shake.
I’d recommend using a polarising filter. Thismight surprise you, as this filter
is often used to reduce reflections, but it can also enhance their colour and
intensity. Now all you need is a suitable body of water and a breezy day –
not too windy though, or the water will be choppy.

TIMEREQUIRED
30MINUTES
EQUIPMENT NEEDED
NIKOND300 AND
80-400MM
TELEZOOMWITH
POLARISING FILTER

Setup
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3COMPOSITION:Don’t
forget to try both

horizontal and vertical
format compositions. It is
possible to achieve very
different-looking results of
the same subject by simply
turning your camera. If you
have a polarising filter
attached, remember that
switching formatswill alter
the degree of polarisation,
so youwill need to adjust
the filter accordingly.

4FOCALLENGTH:One
of themain advantages

of using a telezoom to
capture arty reflections is
the versatility it offers. You
can quickly zoom in or out,
altering the composition
without the fuss of
changing lens. The long
end of a zoomallows you to
highlight specific details,
colours or patterns in the
water. These shots show
the rangeof an80-400mm.

400mm

80mm

Apolariser absorbs around two stops of

light. Your camera adjusts for this, but

you should be aware that the exposure

timewill be lengthened. If it becomes

too slow, raise the ISO to compensate

Polariserproblems!
olariserproblems!
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TIMEREQUIRED
45MINUTES
EQUIPMENT
NIKOND300,150MM
MACROLENS,REMOTE
RELEASEANDTRIPOD
ALSO USED
2xWIMBERLEY
PLAMPS, GERBERA
FLOWER, ATOMISER
SPRAY BOTTLE

ROSSHODDINOTT:You could argue that photographing the refracted image
of a colourful flower through one ormorewater droplets hanging on a stemor
branch is a bit of a cliché, andwith some justification too. However, whilst it
may not be themost original idea, there is no denying that the results can look

eye-catching.Because it hasbeendonemany timesbefore, it is easy tooverlook taking this
type of shot. This is amistake, though. There is nothingwrongwith replicating an idea…
so long as youdo it well, and enjoy the challenge of achieving the final result.

Shoot a colourful flower
refracted in water droplets
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1Just by looking at the rowof droplets, I could see the perfectminiature
refracted image of the flower in every drop. I decided to focus on a couple of

droplets thatwere side by side. Next, I prioritised a large aperture of f/4 in order
to throw the flower behind completely out of focus. I then focused on the droplets
and released the shutter. However, by focusing on the drop itself, rather than the
reflection, the refracted flower imageswere out-of-focus.

2With close-up photography, depth-of-field is often just amatter of
millimetres. Therefore, accurate focusing is critical, which iswhy if your

eyesight allows it, you should always opt for the added precision ofmanual focus.
I carefully alteredmypoint of focus, so that it was on the refracted image of the
flower. However, depth-of-fieldwas so narrow at f/4, that nothing other thanmy
point of focus is recorded as acceptably sharp.

SETTING-UP:This type of image is easy to shoot and should take nomore than
anhour. You can set up in your gardenor indoors, using a small table as your
base. Amacro lenswould be the ideal choice, as they typically have a 1:1
reproduction ratio, but a reversing ring, close-up lens or extension tubewould
alsowork. A remote releasewould also be useful (or if you don't have one, your
DSLR's self-timerwould help), aswould a small reflector. You'll need a nice,
colourful flower to photograph, such as a gerbera or sunflower.

The flower and the object your droplets are hanging fromneed to be clamped
into position, and the droplets should be suspended between 10-30cm in front
of the flower, froma thin reed, grass or branch.Wimberley Plamps are useful for
this, but bulldog clips or tapewould alsowork. Lastly, to create yourdroplets,
use awater sprayer or atomiser. Spray repeatedly until large droplets form
and hang fromyour reed or branch. This can be a rather frustrating process,
so itmay take a few attempts to get the droplets just right.

PLAMPFLEXIBLEARM:
I usedabasic table-top set-up
andbought a large, redgerbera
from the local florist. Thebigger
theflower, thebetter, as itwill
alsobe thebackdrop for the
shot.Mydropletswere
suspended froma freshgreen
reed, frommypond. I attached
twoPlamps to the table; one to
hold the reed inplace, and the
other toposition theflower
around20cmbehind. The reed
needs tobeheldhorizontally,
or thewaterwill run along it,
but the advantageof using
Plamps is that their flexible
armsare easy to adjust and
position. I aligned theflower
and reed so that theflower
headcreateda frame-filling
backdrop.Next, I sprayed the
reedwith anatomiser until a
rowof droplets formed.Having
done this, Imovedmy tripod
intoposition–parallel to the
droplets andflowerbehind.

Essentialkit
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3In aperture-prioritymode, I selected a smaller f/number of f/14. I hoped this
would generate enough depth-of-field to keep the droplets, refracted images

and reed in acceptable focus. The resulting slower shutter speed enhanced the
risk of camera shake, so even the tiniest vibration caused by pressing the shutter
release buttonwould soften the image. Therefore, the use of a remote release
was essential to ensure a sharp result.

4The previous imagewasOK, but the compositionwasn't terribly exciting.
I decided that isolating just two of the droplets didn't create a strong enough

visual impact, so I sprayed the reeds again, to createmore drops, and then
focused on a larger group. Imaintained the settings for the last image, using f/14
with a corresponding shutter speed of 1/4sec. The result wasmore interesting,
but I was certain that I could do better.

Finalimage
Experimentwith vertical and

horizontal compositions and alter the
shooting angle. Sometimes a shallow

depth-of-fieldworks best, and vice
versa. I tried several approaches, but

opted for a composition at a slight
angle to the reed. I then focused on a

single droplet, keeping the flower
within it sharp, whilst everything else

drifted pleasantly out of focus.
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TIMEREQUIRED
45MINUTES
TIMEREQUIRED
45MINUTES
EQUIPMENT USED
NIKOND700, 17-35MM
WIDE-ANGLE LENS

EQUIPMENT USED

WIDE-ANGLE
ALSO USED
TRIPOD, POLARISER
&ND FILTER

ALSO USED
TRIPOD, POLARISER
&ND FILTER

Shooting movement in ascene
ROSSHODDINOTT:Usinga lengthyexposure toblur subjectmovement is apopular
technique that cancreate the impressionofmotionandgive imagesmore life and
dynamism. It is particularlywell-suited to landscapes.This is a very subjective technique,
but I think it can transformagood image intoanexcellent one.However, achieving just the

right amountofblur involvesexperimentingwitha rangeofdifferent exposure times, so it can takea
while toget right, and is fairly hit-and-miss.Watermovement is themostpopular subject for this
technique, though it canworkwellwith subjects includingclouds, people, flowersandgrasses.A
goldenfieldofwheatorbarleycanbehighlyphotogenicas it gently sways in thebreeze.Onabreezy
day, findaviewpointwhereyoucan includeastatic subject to contrastwith themovement, such
asa fence, treeorpylon.Now it’s time tobegin shootingmovement in the landscape.
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1The Daymark is a navigational aid in South Devon. It is an attractive
landmark and I knew that the surrounding farmlandwas planted with corn.

I waited for a fine, breezy evening and visited with the intention of blurring the
crop. However, in programmode, the camera selected an exposure of 1/80sec
at f/11 – too fast to record any obvious subject motion.

2Switch to shutter-priority
mode, which will allow you to

quickly set the slowest shutter
speed available for the ambient
light. I also selected the camera’s
lowest ISO sensitivity, to help
generate a long exposure. Although
longer, the resulting exposure of
1/15sec at f/22wasn’t slow enough
tomake any discernible difference.

SETTINGUP:When using
a lengthy shutter speed
to blur subjectmovement,
a tripod is essential, or
you’ll add your own
movement to that of the
subject. This is a very
different type of ‘blur’,
known as camera shake,
which is almost always
undesirable as it can
ruin a shot by blurring
elements that ought to
be sharply in focus.

3To achieve an exposure slow
enough to record the wind

movement, you’ll need to use
filtration. Polarising filters have a
filter factor of two stops, so I attached
one. Not only did it lengthen the
exposure to 1/4sec at f/22, but it
helped to saturate the colours. I opted
for a low viewpoint, to help to
emphasise themovement.

4Although the previous exposure
recorded an acceptable degree of

motion, I wondered how an even
longer exposure would alter the
image, so I attached a three-stop ND
filter. The resulting exposure was two
seconds. However, themovement of
the crop was now too great. The corn
in the foregroundwas completely
blurred and lookedmessy.

5The key is to take an exposure
that’s long enough tomake the

effect look intentional; yet without
making the subject look
unrecognisable. This will depend on
the subject and wind speed. For this
image, I replaced the three-stop ND
with a two-stop ND filter. In this
instance, an exposure of one second
at f/22 created just the right effect.

To generate the slowest possible shutter speed for the available light,
select the lens’s smallest aperture and lowest ISO sensitivity. This still
may not be slow enough to create the degree of subjectmovement you
require. To lengthen your exposure further, youwill need filters.
NEUTRALDENSITY(ND)filters are designed to absorb light to
artificially lengthen exposures. They are available in both screw-in and
slot-in varieties and a range of densities. Themost common strengths
are one, two and three stops –while B+Woffer a ten-stop filter for
generating exposures of extreme length. A two-stopNDwill suffice in
most situations.When using ND filters, compose and focus your image
before attaching the filter, otherwise the viewfinder imagewill be too
dark. Your TTLmetering will automatically adjust for the filter’s factor.
POLARISINGFILTERSalso absorb light – increasing the exposure time
by around two stops – and can be utilised asmakeshift NDs.

Essentialkit
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Finalimage
Using the same settings, I took a variety of
shots, as no two 'motion' shots are ever the
same. I experimentedwith viewpoints and
composition. I was happywith the results,

but having experimented recentlywith
black&white photography, I decided the

imagewouldworkwell converted tomono.
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1Because a slow shutter speedwill be used to
blur thewatermovement, alwaysmount your

camera on a sturdy tripod to keep it nice and steady.
It’s also a good idea to attach a remote release so
you can trip the shutterwithout touching the
camera, which risks vibrations that could lead to
your images being ruined by shake.

2In dull weather, stopping your lens down to f/16
or f/22 and setting a low ISOmay give you a

shutter speed slow enough to blur thewater. If not,
use aNeutral Density (ND) filter to increase the
exposure. A polarising filter can also be used to
increase the exposure by two stops – so 1/4sec
becomes one second, for example.

3Before taking a shot, check the lens or filter for
water droplets. If you’re shooting close to a

waterfall splashes or spraymay get on the lens. In
this case, drizzlewas the culprit.Wipe thewater
awaywith a cleanmicrofibre cloth, otherwise image
qualitywill suffer. Holding an umbrella over the
camera can help in rainyweather.

4Take your first shot and review it. I was initially attracted to this spout of
water hitting a rock and cascading in all directions. Shooting side-on

proved to be a good angle and a shutter speed of one second offered enough
blur. The shotworked, but thereweremany other options to explore.

5I decided to try awider view, using thewater spout in the previous step as
foreground interest, carrying the eye up the ravine towards the distant peaks

of theCuillin Ridge. It took a few attempts to get the shutter speed just right so
no areas of themovingwaterwere overexposed.

Shootmovingwater
LEE FROST:Although it has become something of
a cliché, using a slow shutter speed to record
movingwater as a graceful,milky blur is an
undeniably effective technique,which iswhy so

manyphotographers, includingmyself, like to use it. From
tumblingmountain streams to bubbling brooks and
thunderingwaterfalls, wherever you findmovingwater, the
samebasic approach canbe used to capture it and turn an
ordinary scene into a creative image that’s full of
atmosphere. Even better,movingwater is best shot on an
overcast daywith soft light so there are noblinding
highlights to contendwith, causedby sunlight reflecting on thewater. Thismakes it a
perfect subject for those dull, grey days photographers in theUKknowsowell!

SELECTASLOWSHUTTERSPEED: Thekey to
successwhen shootingmovingwater is to use a
shutter speed that’s slowenough toblur thewater,
so it recordswith a smooth,milky appearance,
but not so slow that areaswhere thewater ismore
concentrated start to overexposeandburnout.
This is amatter of trial anderror, but anexposure
of one secondusuallymakes agoodstartingpoint.
Thegreat thing about digital capture is that you can
check each shot you take to seehow it looks, then
shortenor lengthen the exposure timeuntil youget
theperfect result. If tiny areasofwater burnout,
don’tworry –whenyoudownload the imagesand
view themas full-size files, chances are those
highlightwarningswill havedisappeared. If not, it’s
a simple job touse theCloneStamp tool in
Photoshop to copyandpastewater fromadifferent
part of the imageover theoverexposedareas.

Techniquewatch
TIMEREQUIRED
30MINUTES
EQUIPMENT USED
CANONEOS-1DSMkIII
WITHCANON
17-40MMZOOM
ALSO USED
NDFILTER,NDGRAD,
TRIPOD,REMOTE
RELEASE,LENSCLOTH



Lightin
g

P
hotoshop

O
utdoor

Indoor
Creative

Waterfalls 4350PHOTOPROJECTS

Finalimage
Here’s the end result, shot with an
exposure of 1.3 seconds at f/22
(ISO 50), using a 0.9ND filter to
increase the exposure and a 0.6ND
hard graduate to hold detail in the
sky. The dull weather and soft light
worked well, perfectly revealing the
subtle colours in the scene, while
the blurred water captures the feel
of the tumbling mountain stream.



TIMEREQUIRED
15 MINUTES
EQUIPMENT USED
NIKOND300&SIGMA
18-200MMLENS
ALSO USED
MODEL&UMBRELLA

Ablastofashutterthat
willblowyouaway!

CAROLINEWILKINSON:DavidBlaine has shownus he
cando it, DerrenBrowndoes it with large tables and,
comeon,we all believed in the power ofMaryPoppins’
umbrella. But is it truth or trickery?Quite frankly though,

who cares? The levitation effect looks great and, evidently, always
leaves peoplewondering how itwas done. UsingPhotoshop to
create the illusion is a skill of its own, usually done through
compositing or removing objects that give a person height.
However, this time, I’mgoing to showyouhow to achieve the effect
entirely in-camera, relying on timing, patience, a very fast shutter
speed and a subjectwho is fit enough to jump time and again!

P
ho

to
sh

op
O

ut
do

or
In

do
or

Li
gh

ti
n

g
Cr

ea
ti

ve
44 Levitationeffect 50PHOTOPROJECTS



Lightin
g

P
hotoshop

O
utdoor

Indoor
Creative

Levitationeffect 4550PHOTOPROJECTS



POSITION&SHUTTERSPEED!
There are two factors thatwill
determine success or failure: the
shutter speed and the subject’s
position. Use as fast a shutter speed
as possible to freeze the subject in
mid-air, ideally at the top of the jump,
when they are furthest from the
ground.Watch themodel’s feet too. If
they’re pointed down theywillmask
the distance between foot andfloor
whichmakes the shot so effective.

Techniquewatch

1I tried this technique in afield andon concrete, but
neitherworkedaswell as being on topof a hill with

just sky as background. To capture the all-important
height, try a contrasting backdropbehind the feet, adding
a shadowor standing someonenext to themodel to
benchmark howhigh they are off the ground.

2Bystandingparallel to themodel, so her feetweren’t
atmyeye line, itwas hard to tell that she hadmuch

distance off the ground.Having chosen tomove to a hill,
it allowedme topositionmyself belowher for anupward
viewpoint that really helpedmecapture the full distance
when she jumped.

3 I setmycamera to shutter-priority and
ContinuousAF,which continually adjusts

the focus onamoving subject to keep the
image crisp. I also set the camera toCH
(continuous high shootingmode) to increase
myshooting rate. You canalways try to
predict the time to hit the shutter release, but
I found it easier to hold it down from the
moment she left the ground.

4The success of the illusion relies on the
subject looking like they're levitating.

Toget this effect requires a fast shutter
speed, so I set the ISO to640 to letme set
the shutter to 1/8000sec. This frozemy
subject butmy timingwasoff so Imissed
her at the peakof her leap. I tried again, and
did better, but her feet pointeddown,
obscuring howhigh shehad jumped.

Techniquewatch

The effect works better if your subject

looks up at the umbrella. It avoids any

unflattering expressions createdwhile

jumping and gives the impression that

the umbrella is the cause of the levitation

Thingsarelookingup!

Thingsarelookingup!
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Finalimage
Timing is everything with
this technique. Just keep

your subject jumping, don't
stop shooting, and you will
eventually get the shot you

want. I tweaked the Hue and
Saturation of this image to
pump up the vivid colour.
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Photographour
feathered friends

ROSSHODDINOTT: If you have a garden, I expect
you also share it with a number of birds. The
averageUKgarden is visited by awide variety,
with blue tits, great tits, chaffinches, robins,

sparrows andblackbirds being themostwidespread.
Wildlife photography is a very popular subject and, at one
timeor another,most digital photographerswill be tempted
to try snapping the birds in their backyard. Bird photography
isn’t easy, though, and canprove challenging and
frustrating. However, with a little planning, patience and
bribery – in the formofwild bird food – it is possible to
capture stunning bird images. Youmay evenbe able to do so
from the comfort of your very own living roomor kitchen.

TIMEREQUIRED
THREE DAYS
EQUIPMENT NEEDED
NIKOND300, SIGMA
120-400MM& TRIPOD
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3I wanted to capture some nice, natural-looking bird images. Therefore, I
didn’t want to photograph the birds on the feeder. Instead, I introduced one

or two props nearby that visiting birds would hopefully use to rest on between
feeds. You could try anything, for example, position a branch of colourful
blossom adjacent to your feeder, or maybe a clothes line with pegs in order to
create an urban-looking shot. In this instance, I opted for the handle of an old
spade, positioned next to the feeder.

2To entice birds within range of your lens, you will need to bribe them. You
can do this in the form of food or water. If you already have a bird feeder in

your garden, just move it within a fewmetres of your ‘hide’. If not, buy a
feeder from a local garden centre and position it close to your set-up. Only
buy recommendedwild bird seed and peanuts. Within days, hours, or even
minutes, birds will be visiting your ‘feeding station’. Keep feeders full, so that
birds get in the habit of visiting regularly.

4Garden birds are flighty – they don’t stay still long – so you need to
prioritise a fast shutter speed to freeze their movement. Shutter-priority is

themode best suited to this type of photography. Ideally, a speed upwards of
1/400sec is needed, otherwise your shotsmay suffer from subject blur. Select
themaximum aperture of your lens and, if necessary, increase the ISO rating.
Despite using a shutter speed of 1/250sec, my first few images suffered from
subject blur, so I raised the ISO from 100 to 200.

TELEPHOTOLENS:
Gardenbirds are small
andeven if you can
entice themwithin three
metres of your camera,
you’ll still needa focal
lengthupwardsof
300mmtocapture
frame-filling shots.
Thankfully, telezoomsare
not as costly thesedays.
The longendof a 70-300mm
zoomshouldprove sufficient, particularly in
combinationwith aDSLRwith a cropped type
sensor – as its focal lengthwill effectively be
increasedbya factor of around 1.5x. Theonly
problem tousingbudget telephotos is that they
tend tohavea relatively pedestrianmaximum
aperture, typically f/5.6. Consequently, shutter
speedsare slower,making itmoredifficult to
freeze subjectmovement. In gooddaylight
though, using a lenswith a slowermaximum
aperture shouldn’t be aproblem.

Essentialkit

1/250sec 1/500sec

1To capture visiting birds, you first need to decide how you are going to
conceal your whereabouts. Most wild birds are quite timid and easily

frightened away.While a hide is ideal, it is an added cost. Instead, try using a
garden shed or a household window. Buy camouflage netting from your local
army surplus supplies or www.wildlifewatchingsupplies.co.uk and hang this
across your open door or window to create amakeshift hide. You can then
poke your lens through the netting, keeping yourself hidden.
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5When using a telezoomwith a large aperture, depth-of-field will be very
shallow. This is useful for throwing background and foreground detail out

of focus and helping to isolate your subject. However, such a limited
depth-of-fieldmeans you need to focus with pinpoint accuracy. Try to focus on
the bird’s eyes – if these aren’t sharp, the imagewill be ruined. AF is the best
and quickest method of focusing when shooting fast-moving small birds, so I
set my D300 to its continuous AF trackingmode.

6One of the key points to taking goodwildlife pictures is to be patient and
persevere. Withmy set-up complete, I invested several hours over the

course of three days atmy studio window shooting the visiting birds.
Sometimes I had to wait more than an hour before a bird would use the perch.
Be prepared to spend lots of time and take lots of frames before getting the
shot you are after. You will have lots of ‘nearmisses’, but the good shotsmore
thanmake up for them.

FinalimageFinalimage
Thewaiting has paid off!

Why not try snapping your
garden visitors today?

Set up your feeding station and ‘props’
in an area that receives good light for
several hours of a day. Avoid placing it
somewhere that is shaded by a
building, a fence, hedges or trees

Planforthelight
anforthelight
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3One thing that's very difficult when shooting such shiny surfaces as the
chrome decals of a car, is to keep your own reflection out of the frame. To

start with, I used a tripod on self-timermode tominimise the reflection, but the
camerawas still reflected. It also increased the time for each shot and took a lot
of the spontaneity out of it, so I decided to shoot handheld instead.

1As it was a fairly bright day, but slightly overcast, I setmy ISO rating to 200.
This would giveme a fast enough shutter speed, and keep the noise levels

relatively low in the images. I set theWhite Balance to 'Daylight', although I
changed it to 'Cloudy' later on. I used aperture-priority with the lens at its widest
aperture, f/4, to limit the depth-of-field for amore arty effect.

4 Inmy bid to shoot the car from some unusual angles, I found it necessary
to lie on the ground. I find shooting from a lying-down positionmuch easier

andmore comfortable than crouching and strainingmy neck. It also allowsme
to hold the cameramore steadily. If you don't want to get dirty, use aDSLRwith
Live View or fit a right-angle viewfinder attachment.

4Once I'd ensured thatmy camerawas correctly set up, andmymemory card
was in place and formatted, I attached a circular polarising filter tomy lens.

This is a simple process, as the polariser simply screws into the filter thread at
the end of the lens. Polarisers can be really useful for bringing out colours and
cloud details. To be honest, this one rarely leavesmy lens.

THESETUP:Once I arrived at the
showroom, I had a lot of cars to choose from.
I decidedon a redMini, for its strong colour
anddistinctiveUnion Flag roof. I askedAlex
tomove the car onto a grass verge, so that
the showroomandnearby carswould not
reflect in the bodywork. I also felt that a
cleanbackground consisting simply of the
greengrass and cloudyblue skywouldwork
betterwith these shots than the showroom's
exteriorwould. I turnedon the lights, aswell
as the orangewarning lights,which I thought
would adda little bit of extra interest to some
of the less colourful parts of the car.

Capture interesting detailshots of your car
STEWARTBYWATER:
A funway tomake some
striking, colourful images is to
shoot car close-ups. Carsmake

great subjects, as they have somany
details and angles, and you can shoot
them anywhere, frombeautiful landscape
locations to just outside your home. Bright
sunshine will emphasise the colours of the
bodywork, but don’t let cloudy conditions
put you off. If it’s bright, the clouds will be
reflected, adding interest to the shots.
Either way, it’s easy to get great results
withminimal effort. Do keep inmind that
buildings or objects near your car will also
be reflected in the glass or the bodywork
though. I chose to shoot aMini, as they're
instantly recognisable, with lots of
fantastic details and curves. Many thanks
to Alex at Sycamore BMW in
Peterborough, whowas kind enough to
lendme one. To see their excellent range
of new and pre-owned cars, please visit:
www.sycamorebmw.co.uk

ALSO USED
MINI COOPER

TIMEREQUIRED
30MINUTES

EQUIPMENT NEEDED
CANON EOS 10D &
17-40MM F/4 L LENS,
POLARISING FILTER

POLARISER: IusedacircularpolarisingfilteronmyCanonEF
17-40mmf/4 lens.Rotating thefiltermeant thatnotonlywere the
detailsonthecaraccentuated, Icouldalsomanipulate the
reflectionsontheglassandnon-metallicpartsof thecar, suchas
thewindscreenandbodywork.However,polarisingfiltersdonot
affectmetallic reflections,sobeawareofyoursurroundings,as they
willbereflected inanychromeorsteelparts.Perhapsthemost
importantbenefitofusingapolariser for this technique,however, is
that theyreallyhelp tosaturate thecoloursofacar,giving theshots
areallyvivid lookandmakingthemstandoutmore.

Essentialkit
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Finalimages
BecauseIhaduseda

polarisingfilter, thecolours
andsaturationwerenot

consistent inallofmyshots.
However,shooting inRaw

formatenabledmetoadjust
thisbeforeopeningthe images
inPhotoshop. Ialsoaddeda
littlecontrastandtweakedthe
saturationwherenecessary.

Finally, IusedtheCloneStamp
tool toremovethe lampposts
andanybitsofdirtordust from
myshots. Idecidedto leavethe
reflectionsastheywere,but
thesecouldalsobeclonedout

inPhotoshopifdesired.
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Staysimplewithdaylight
DANIELLEZANO:Many leading lifestyle portrait photographers use
nothingmore than ambient daylight for the vastmajority of their
portrait shoots. So,whilewehave the benefits of bright, sunny days at
our disposal, we should use it to capture some simple yet effective

portraits of family and friends. The best thing about shooting lifestyle portraits is
that you cando it with theminimumamount of equipment – yourDSLRorCSC
with a kit lens is enough– although I’musingmy favourite optic, the humble
(and cheap!) 50mm lens. Due to the unpredictable nature of daylight, lighting
aids such as a reflector and adiffuser can come in handy too, but aren’t
essential. The key thing to remember is that youwant to capture a ‘clean’ image,
in otherwords try to keep the subject and the setting as simple as possible. I’ve
opted for the classic combination of havingmy subject, Bethany, wear awhite
top and jeans, and shot her lying onmydining room's laminate flooring.

TIMEREQUIRED
15 MINUTES
TIMEREQUIRED
15 MINUTES
EQUIPMENT USED
CANON EOS 5DMKII
WITH 50MM F/1.8

EQUIPMENT USED
CANON EOS 5DMKII
WITH 50MM F/1.8
ALSO USED
SILVER REFLECTOR&
LASTOLITE DIFFUSER

ALSO USED
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2Myfirst shot is just a tester for composition and exposure. I’ve a pretty
clear idea inmy head of the type of shot I’m looking for, with Bethany

lying downwith her lower legs and feet bent back towards her head. This
shot isn’t bad, but the side-lighting causes her right side to be too dark.

3 I place a silver reflector to Bethany's right just out of frame and itmakes
a noticeable difference, bouncing back enough light to even out the

lighting on the face. The lighting’s better, but thewall behind, while plain,
causes thewhole scene to appear a little too cramped formy liking.

DIFFUSEDDAYLIGHT:For flattering portraits, the light should be as
diffused as possible to avoid yourmodel squinting in direct
sunlight or having the light on their face too harsh. In this instance,
try to reposition them so they’re in the shade or use a diffuser to
shade the scene (inset right). If neither of these work, youmay
need to wait until the sun’s position changes or shoot when the sky
ismore overcast. A silver reflector is handy evenwhen shooting in
non-directional light to fill in shadows.

Techniquewatch1Mydining room is quite small, so I’ve
had to clear it completely of furniture.

Asmy subjectwill be lying on thefloor, I
vacuum it to ensure it’s as cleanaspossible.
Due to the cramped space, I open the patio
doors in case I need to shoot from thepatio.
However, I’ll start by shooting fromwithin
the roomanduse thewhitewalls as a
neutral backdrop.Using awide aperture to
give a shallowdepth-of-field is ideal for this
type of shot and I’ll be trying outmy
50mm’smaximumaperture of f/1.8,
although I’ll takemost of the images at
f/2.5-3.5 as itwill improve sharpness.

SHOOTATASLANT:One
compositional trick thatmost
lifestyle photographers apply to
their images is to slant the
camera so that the images are
capturedwith an unevenhorizon.
This simple technique adds a
little energy into the imageand is
very effective – just take care not
to tilt the camera too far.

You need to ensure your focusing is
precise as using awide aperture, which
gives limited depth-of-field, leaves little
margin for error. Select single-point AF,
lock the focus on the eye and recompose

Takecarewithfocus!
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Finalimage
Mynext shot is perfect and

all I need to do is applyminimal
post-production. I’ve boosted

the contrast in Curves and
cropped the image slightly to give

me the result I set out to shoot.
Give it a try – you’ll be surprised

just howeasy it is to shoot a great
lifestyle portrait at home.

4I shift Bethany andmyposition so that I’m now shooting into the room
from the patio rather than from the side. I close the blinds in the

backdrop so to darken the background. The empty space created behind her
is an improvement over the original set-up butmy viewpoint is too high.

5I crouch down and the lower viewpoint is far better but themulti-zone
meter has bleached out Bethany slightly due to the dark background

causing it to overexpose the scene. This is easily taken care of by dialling in
somenegative exposure compensation. I find -2/3EV is ideal.



Essentialkit

1I wanted tocreatea fun, colourful image.Soaftermuchdeliberating,
I decided tophotograph the refracted imageof somecolourful sweets.

Todoso, I neededsomeglassorclearplastic toplacemydropletson–
I opted for the lidofaCDcase.Tocreateandpositionmyreflectivedroplets,
I decided touseasyringe,butadropperorwater spraywouldalsowork.

3Usinga tripod, I positionedmycameradirectlyoverhead, keeping it parallel to
maximisedepth-of-field. I composedmyshotandcarefully focusedon the

refracted imagewithin thedroplets–not thedroplets' surfaces. I startedwitha
largeapertureof f/4,but thedepth-of-fieldwas toonarrowandeverythingother
than the reflected imageswasoutof focus.

2I arranged thesweetsonablacksurface. I then rolled-upand tapedasheetof
whitecard intoacylindrical shape,placing it around thesweets, tohelp reflect

lightevenlyand tocreateamakeshift ‘stand’onwhich toplace theCD lid.Using
thesyringe, I carefully createdaseriesof tinydropletson theCDcase–eachdrop
creatinga refracted imageof thesweetsbelow.

TRIPOD&REMOTERELEASE
To achieve enoughdepth-of-field to
keepboth the droplet and refracted
image in acceptable focus, youwill
need to select a small aperture. This
will result in a slow shutter speed,
making the use of a tripod essential
to keep the camera shake-free and
to allow you to accurately select your
point of focus. Capturing frame-filling
images of tinywater droplets requires
shooting at a relatively high level of
magnification –when even the tiniest
movement seemsgreatly
exaggerated. Using a remote release
is preferable to physically releasing
the shutterwith your finger, which can
create slight vibrations that can
soften the final image. If you don’t
have a remote release, use your
camera’s self-timer facility.

Fun with refraction
ROSSHODDINOTT:Refraction
is the directional shift or
‘bending’ of light rays as they
leave onedensity and enter

another – it is the reasonwhy your legs
look shorter underwaterwhen viewed
fromabove the surface. Theway in
whichwater refracts and reflects its
surroundings, and nearby objects,
offers endless creative potential for
photographers.Water droplets act like
tiny ‘lenses’ reflecting perfect,miniature,
reversed imageswithin them.
Photographed in close-up, using either amacro lens or close-up
attachment, you can capture this striking effect. Colourful flowers look
particularly goodwhenphotographed through awater droplet –
creating an ‘imagewithin an image’. You could try taking pictures
outside after rainfall or a dewynightwhen foliage is dripping. However,
this gives you little control over the image reflectedwithin your
droplet, and you also have to considerwindmovement. Instead,why
not arrange a simple, table-top set-up indoors and create your own
refraction photos?Bydoing so, you candecide exactlywhatwill be
reflectedwithin your droplets. You can have all sorts of fun using
different subjects; for example, you could use text, flowers, a flag, a

TIMEREQUIRED
45MINUTES
EQUIPMENT USED
NIKOND300 &
SIGMA 150MM
MACRO LENS
ALSO USED
SWEETS, CD CASE,
PAPER & SYRINGE
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4I changed theaperture to f/22 to increasedepth-of-field.The resulting
shutter speedwas twoseconds, soa tripodandremote releaseproved

essential. The result had farmore impact– thedropletswere in focus, and the
sweetsbehindmadeacolourful background.However, dustandscratcheson the
plasticwerealsonowvisiblebecauseof thesmalleraperture.

5Thenext stepwas to tidyupmy image.Even though Ihadwipedover the
plastic casebefore Ibeganshooting, tinymarkswereobviousacross the

image.UsingacombinationofPhotoshop'sClone tool andHealingBrush,
I carefully cleaned the image. I thenadjusted theLevels to increasecontrast,
upping thesaturationslightly too, inHue/Saturation, toadd impact.

With this type of image, it is important to

manually focus on the refracted image

itself, not on the surface of thewater

droplet, as the AF systemmay struggle

to predict your desired point of focus

Focusontheimage
Focusontheimage
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1FOCUSPROBLEMS I set aperture-prioritymode and, for optimumquality,
a low ISOof 100.One thing I haven't set yet is the autofocus. I leave it at

multi-point, just to demonstratewhat happens.With all AF points active, the
camera focuses on the closest part of the subject, which is on the far left of the
frame. Switching to single-point AF and setting theAF point over the area I want
to focus sorts this out. Another option is to usemanual focus.

2FINE-TUNETHECOMPOSITIONWith focusing solved, take a shot and check
the histogram. You should find that unless the flower is very light or dark,

your exposures are correct. Now concentrate on the composition.Make small
adjustments to the tripod head, raise or lower the legs andmove the flower until
you're happywith how it's framed. LiveViewproves very useful, as you can
monitor changesmore easily than if using the viewfinder.

THESET-UP:The great thing about close-up flower photography is you don't
need an elaborate set-up. The area close to the French doors inmydining room
provided all the light I needed for the shoot. The rosewas balanced in a
half-filled plasticwater bottle to hold it in position, whilemy camerawith
macro lens is set up on a tripod. I find that shooting a flower indoors offers two
key advantages: wind blowing the flower isn't an issue and shooting in the
shade provides a far gentler light. Finally, it's worth keeping a silver
reflector on hand should you need to bounce some light back into the scene.

Capturearose’sbeauty
DANIELLEZANO: If you've never tried photographing a
flower, I'd suggest you give it a go. As a photographer
who has concentratedmainly on portraiture, the
enjoyment I found fromcomposingmy first ever flower

still-life came as nothing short of a revelation. It's an incredibly
rewarding formof photography, which allows you to practise
your skills with composition and lighting, aswell as testing your
creativity by trying to find different angles and viewpoints to
shoot from. The sheer variety of beautiful flowers availablewill
give you endless options for your still-life. My personal favourite
is the gerbera, but it is run a close second by the elegant beauty
of the rose. However, I find the gerbera to be a far easier flower
to photograph, as its shape allows you to capture it fromall
sorts of angles and crops. Inmy view, the rose is amuch harder
proposition; it ismore fragile and the folds of its petals can
mean that not every one you find is a suitable subject for
photography. In the past, when I've bought roses, I've
specifically headed to a good florist and delved through their
selection for the perfect subject. For this step-by-step however,
I snipped roses froma neighbour's garden (with permission of
course!) to show that it is possible to find a suitable subject
even among ordinary flowers from the garden.

TIMEREQUIRED
30MINUTES
EQUIPMENT NEEDED
CANON EOS 500D&
100MMMACRO LENS
MANFROTTO 055MF4
TRIPODWITH RC322
HEAD& REFLECTOR
ALSO USED
PINK GARDEN ROSE

MACRO LENS & TRIPOD:
Because we’re trying to fill
the frame with a very small
subject, a macro lens is pretty
much an essential bit of
kit. It will allow you to focus
within a few centimetres from
your subject and exclude the
background from the frame,
so that the entire image is
filled with your flower. Now
it’s fair to say that you can get
away with shooting handheld
here, especially if your
camera or lens has an image
stabilisation facility, but I’d
highly recommend that you
do use a tripod. Using one will
allow you to fine-tune your
compositions, ensure your
focusing is absolutely precise
(this is absolutely critical with
macro photography)
and also let you shoot a
series of identical shots
at different aperture
settings so that you
can later choose the
one that you prefer.

Essentialkit
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4APERTURESETTINGSOnce you're happywith the composition and
lighting, take a series of exposures at one-stop intervals frommaximum to

minimumaperture to give you a complete set, fromminimal depth-of-field to as
much as possible in focus. Tominimise shake in the longer exposures, use the
self-timer or a remote release to fire the shutter.

3USEAREFLECTOR IFREQUIRED Iwas pleasedwith the composition of the
image, but not so happy that the side of the flower closest to thewindowwas

much brighter than the right side. I balanced this out by restingmy reflector on
the tripod leg closest to the flower. The light it bounces back is subtle, but I'm
happywith the difference itmakes to the image.

Finalimage
The advantage of buying from

aflorist is that your subject
will have fewer imperfections.

This garden rose had a few
discoloured areas, but they
were easily cleaned upwith

theHealingBrush tool in
Photoshop. After 15minutes of
photography andfiveminutes
of Photoshop, I've a beautiful
still-life of a flower to add to

my colourful collection!

f/32

f/2.8
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Howtotakeaperfectbath-timeportrait
ROSSHODDINOTT:Whilst some photographersmight have access to a
studio, or own a home studio set-up and lights, themajority of us don't.
So what canwe dowhenwe're stuck at home on a cold, wet winter day,
to create studio-like results?Well, have you ever considered using your

bath? No, not for a relaxing soak, but to reflect light. A white tubwill act like a
large reflector – reflecting light entering through an adjacent window (or a burst
of flash), evenly around a subject placed in the bath. It will also form a clean,
white backdrop – helping create attractive, high-key results. To put this theory to
the test, I decided to take some fresh portraits ofmy two-year old daughter; but
would she stay still long enough forme to take a good picture?

TIMEREQUIRED
30MINUTES
EQUIPMENT USED
NIKOND300 &
105MMMACRO LENS
ALSO USED
WHITE BATH
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1I'm not a portrait photographer and don't have access to a proper studio, so
when I take pictures indoors, I have to improvise. I wanted to take some

fresh shots of my daughter but the initial results were disappointing. When
simply taking shots of her in our lounge at home, dark, unflattering shadows
formed underneath her eyes, mouth and chin.

2With the help of a few chocolate buttons,my daughter sat in the bath.
Although confused by the lack ofwater, she happily smiledwhile I began

taking pictures. The light entering through thewindowbounced around the bath,
creating amore flattering light source. The tub formed a clean, simple backdrop,
but her eyes lacked a catchlight – vital for creating depth and life.

HISTOGRAMS:Regularly check your image’s histogram
to ensure exposure is accurate.Whilst photographingmy
daughter in the bath, I relied on the histogram to ensure
that the bright, white bath tubwasn’t foolingmymetering
into underexposure – something which would have been
indicated by peaks to the left of the graph.

Techniquewatch
MACROLENS:Theonly limitation
of using abath as amakeshift
‘reflector’ is the size of the subjects
that you can shoot. Theymustn’t
exceed theheight of the tub, so
select anobjectwhich isn’t toobig.
Due to the typeor size of the
subjects youwill be shooting, a focal
length in the regionof 100-150mm
is ideally suited. Amacro lens is
ideal, due to its close focusing
ability. Tophotographmydaughter,
I usedaSigma 105mmmacro. This
is apopular lenswithportrait
photographers, as it allows you to
takepictures fromacomfortable
distanceaway fromyour sitter,while
its f/2.8maximumaperture creates
abright viewfinder image.

Essentialkit
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3To create a catchlight, I employed a small burst of fill-flash. I usedmyNikon
D300’s built-in unit, with a flash exposure compensation of -2 stops, to

ensure the burst didn’t overwhelm the ambient light. Not only did the burst
create a catchlight, but it bouncedmore light around the bath tub. However, this
timemy focusing let me down – the eyes are not critically sharp.

4I selected the lens’s largest aperture of f2/8 to throw the tub out of focus, so
it was unrecognisable, and to give a fast enough shutter speed to allowme

to work handheld. However, the resulting depth-of-field was narrow,making
accurate focusing critical. It is essential that eyes are sharp, so I tried again,
taking extra care to ensure the eye closest tomewas sharply focused.

Finalimage
When shooting portraits, you often have

to shoot a large sequence of images
before you get the light, composition and

pose just right. After many chocolate
buttons, I’d managed to take a couple of
shots I was really happy with – nicely lit

portraits, taken with the simplest of set-ups.
Finally, don’t overlook the possibility of
converting your image to black & white.

In Photoshop, one of the best methods is
Image>Adjustments>Channel Mixer. Check

the Monochrome box and try to keep the
combined total for channels to 100.



3Carefully, Imoved the letters back onto the dish. To ensure PHOTODIY
stood out I left a small gap around thewords. I then held the spoon in

position, just above the dish, using a clamp. I focused on the spoon, but to
ensure thewords in the backgroundwere still distinguishable, I selected an
aperture of f/11 to provide sufficient depth-of-field.

1Firstly, I opened the tin of soup and poured the contents into a flat, white
dish. Using tweezers, I began picking out the letters I required. In this

instance, I thought it apt to spell out PHOTODIY. However, evenwith tweezers,
you have to be gentle not to damage or break the letters, but after a few
minutes, I soon found the letters I needed formy chosen phrase.

4I wasn’t happywith either ofmy previous efforts, so I decided to dispense
with the spoon – instead of creating interest, it was proving a distraction.

This time, I cropped in tighter, filling the framewith the alphabet spaghetti.
Thewindow light provided ample lighting and I used a tripod to ensuremy
picture remained shake-free at an exposure of 1/4sec at f/11.

2 I thought it would be fun to havemywords on a spoon as it would help the
letters stand out and the spoonwould add visual interest. Again using

tweezers, I arranged the letters. However, while the ideawas good, in practice
the letters all slid together as themetal is scooped, distorting their shape and
making thewords tricky to read.

GETTINGSTARTED:
I used awhite products
table asmybase, but
any table or kitchen
surfacewill workwell.
Keep some kitchen
towel nearby too:
alphabet soup is
messy stuff and easy
to get on your hands
when you arepicking
out and arranging
your letterswith
tweezers. You don’t
want to transfer
tomato sauce from
your hand to your
valuable camera gear!

Alphabet soup
TIMEREQUIRED
45MINUTES
EQUIPMENT NEEDED
NIKOND300, SIGMA
105MM, TRIPOD
ALSO USED
SPOON, DISH,
TWEEZERS AND TIN
OF ALPHABET SOUP

ROSSHODDINOTT:
I possess a complete lack
of culinary skills… just ask
mypoorwife! I’mhopeless

in the kitchen,which iswhy it is
safer for everyone concerned if I
photograph food rather than
prepare it for eating! Opening a tin
of beans or soup is just aboutmy
limit.My little girls love alphabet
spaghetti and it waswatchingmy
older daughtermakingwordswith the letters that gotme thinking
about the picture potential. I decided to raid the cupboard and
have fun spelling out specificwords using the alphabet soup. This
is a fun shot to try and it couldn’t be easier or cheaper to do. You
canbuy a couple of small tins for under a pound at your local
supermarket, and then all that is required are a feweveryday
household bits andpieces. I useda small still-life table to arrange
myset-up, althougha simple tabletop set-up in your kitchenor
living roomwoulddo the jobequallywell. Rather thanusingflash,
the soft natural light fromanadjacentwindow is ideally suited to
this typeof still-life image. Time to start spelling…
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Finalimage
I decided the alphabet
spaghetti would look
better shot in a vertical
composition. The format
changemeant I had to
rearrange the surrounding
letters, leaving a larger
gap aroundPHOTODIY.
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Makea splash!
ROSSHODDINOTT:Water is highly photogenic,
whether in large quantities or a tiny droplet. H2O
seems to be irresistible to photographers: they can
'suspend' it by using a fast shutter speed or render it

as amilky blurwith a lengthy exposure, capture reflections
off its surface or use it to add the feeling ofmotion to an
image. There is an infinite number ofways to shoot it, so it's
nowonder thatwater features in somany of our images.
Onepicture thatmanyphotographerswant to take is a

close-up of a droplet splashing intowater. Yes, it is a bit of a
cliché, but donewell it creates a very striking image.
Youdon’t needmuch room; a simple tabletop set-up in

your kitchen or living roomwill suffice. And you only need a
basic set-up: a digital camera; close-up filter ormacro lens;
a single flashgun and ahandful of everyday bits andbobs.
Within half an hour or so, you canbe set up and ready to
begin taking beautiful images of sculpturedwater droplets.

TIMEREQUIRED
30MINUTES
EQUIPMENT NEEDED
NIKOND300, SIGMA
105MM LENS, TRIPOD,
REMOTE RELEASE,
SPEEDLIGHT SB-800
FLASH& FLASH CORD
ALSO USED
CONTAINER, PLASTIC
BAG, PENCIL & TOWEL
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2I positionmy tripod-mountedNikonD300 so it's shooting down into the
water tray. Next, it's time to consider lighting. You need to illuminatewhat

you see reflected in thewater through the viewfinder – not thewater itself. I
placed a sheet of white card at the end of the tray to create a simple background
and angledmyflashgun towards the card.

1Before you begin taking pictures, you need to arrange your set-up. Youwill
need a container, half to three-quarters full of water, for your droplet to fall

into. I used a paint tray but any large, shallow containerwill do. I placed this on a
still-life table, but a simple tabletop set-upwould do fine. Next, suspend a bag –
partially full of water – 30-60cmdirectly overhead.

3Now the technical bit. It's the pulse of the flashgun that dictates your shutter
speed. I rarely use flashmyself, but it's fairly straightforward. I set it to its

Manualmode and dialled in 1/16th power to generate a fast enough speed to
freeze the droplets. This is a good starting point so I recommend you use the
same andmake adjustments after reviewing results.

FLASHGUN:
An off-camera
flash is
required for
this technique.
You need a
flashgun that
can be used
via a wireless
transmitter or
TTL flash cord.
The flashgun
then needs to
be positioned so
that it illuminates
the surface being
reflected in the water –
in other words, you direct
the flash burst at the water
droplet’s background. Adjust
power output and move the
flashgun to different positions
to alter the final result.

Essentialkit
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4Imade a tiny hole in the bag using a pin to create a constant drip and held a
pencil in thewater at the pointwhere the dropletswere falling so that I could

focusmanually. I set an aperture of f/8 to generate enough depth-of-field to keep
the droplet sharp but render any ripples attractively out of focus. I set the flash
sync speed to 1/200sec and set a low ISO rating of 200 foo optimumquality.

5Time to get started. Good timing and a huge slice of luck are required, so take
lots of shots – hundreds possibly – to getwhat you are after. It is an

unpredictable technique and every image is different. Expect lots of ‘near
misses’, such aswater ripples but no droplet. I found a remote release helpedmy
timing, releasing the shutter as the droplet hit thewater.

Finalimage
After 30minutes, I had taken

somenice images but they
lacked colour, so I altered

White Balance fromAuto to
its TungstenWBpreset.

Deliberatingmismatching
WB in thisway gavemyfinal

image a blue hue.
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1I cover a studio tablewith a black cloth, adding a sheet of glass (a ceramic
dishwill also suffice) to reduce any risk of fire. I then stick the incense stick to

the glasswith Blu-Tack. Imountmyflashgun behind the incense, with a piece of
black card stuck to the far side of it, to prevent the light spilling out onto the
background. I set upmy camera (andwireless flash trigger) on a tripod, and open
windows to ensure that the room is properly ventilated.

2I setmy camera toManualmode and switch the
lens tomanual focus, pre-focusing for the area

just above the incense. I set a shutter speed of
1/200sec –my camera's fastest flash sync speed
– and an aperture of f/14, to giveme sufficient
depth-of-field. I also setmy camera to record the
images in Raw format, as thiswill not only provide
the best quality images possible, it will also allowme
to enrich the blacks in the conversion process.

3Once I’m ready to start shooting, I carefully light
the incense,making sure that the stick is stuck

securely and in no danger of falling onto the black
fabric. For comfort's sake, I use a remote release to
fire the shutter. Once I have taken between 30 and
40 shots, Imake sure that the incense is completely
extinguished and then review the images onmyLCD
screen. I'mmainly looking to check that no light
from the flashgun has hit the background.

4Once I am satisfiedwith the results, I upload the
images tomy computer. In Adobe's Camera

Rawconverter, I use theBlacks slider to darken the
background before opening the file. I then use the
Eraser tool in Photoshop to clean up any unwanted
smoke spread. Next, I invert the image (Image>
Adjustments>Invert). Thiswill change the smoke
trails to a hazy black and the background to a crisp,
purewhite –making the image stand outmore.

5To add further interest to the shot and give it a real impact, I decide to add
some colour. In Photoshop's Hue/Saturation palette, I tick theColorize and

Previewboxes, beforemoving the sliders around until I'm happy. I choose this
rich red colour, and a saturation of 75 per cent. I then save the image under a
newfile name.Next, I open a different image and repeat steps three and four,
but I decide to colour the second smoke trail with a rich blue.

6With both shots open, I copy the blue one (Select>Select All; Edit>Copy)
and paste it onto the red image (Edit>Paste). I reduce the opacity of the

blue image andmove it around until it looks good. To align the images, I use the
Free Transform tool (Ctrl+T). I then return the opacity of the blue layer to 100%
and change the Layer BlendingMode fromNormal toMultiply. Finally, I flatten
the image (Layer>Flatten Image) and save as a newfile again.

Original Inverted

Shootsome
smoke trails

SAILESHPATEL:
Aneasyway to create
stunning, abstract
imageswith amystical

air is to shoot somesmoke trails.
I've used incense sticks for this
technique, as they are relatively
safe for indoor use andprovide
just the right viscosity of smoke
for this sort of result. As the
smokealways rises in a slightly
differentway, there's an infinite
variety of shapes andpatterns to
shoot.Onceyou'vecapturedyour
smoke trail shots, there's also awealth of options for adjusting
them to create some trulymagical results. Each trail canbe
coloured, flipped, dodged, burnedor distorted inpost-production
to create other shapes. There is literally no limit to thepotential of
this technique.However, it is important to ensure that the incense
sticks areused responsibly, as they cancausefires.Make sure
that once they are lit, you staywith themat all times.

TIMEREQUIRED
45MINUTES
EQUIPMENT NEEDED
CANON EOS 10DWITH
100MMMACRO LENS,
CANON SPEEDLITE 430EX
FLASHGUN,WIRELESS
FLASH TRIGGER
ALSO USED
BLACK FABRIC & CARD,
INCENSE STICKS, SHEET
OF GLASS, STUDIO TABLE
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Finalimage
After a fewfinal tweaks to
theCurves, Saturation and
Contrast, I'm very happy

withmyfinal image. It is a
very colourful abstract that

could look great as a
canvas print on anywall.
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TIMEREQUIRED
20MINUTES
EQUIPMENT NEEDED
CANON EOS 10D
100MM F/2.8MACRO
TRIPOD& REMOTE
STUDIOFLASH LIGHTS
ALSO USED
COFFEE JAR, LEMON
& LIME, SPARKLING
WATER & ICE CUBES

Shoot fruit!
STEWARTBYWATER: Inspiration for an image can
come fromanywhere, and I got the idea for this shot
when I sawabillboard advertising a particular brand of
alcoholic drink. The technique I used is a great one to

try, as it allows you to produce a varied series of images, simply
bymaking veryminor adjustments. I decided to backlight the
fruit to give it a slight glow, and to try and capture the bubbles as
they rose to the top, to create amore dynamic image.
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1Once I’d got allmy ingredients together, I cleaned the jarwith a soft tea towel
(being careful not to leave any fibres on the glass). I filled the jarwith ice,

sliced the fruit and slid them into position (trying not to rub them toomuch on
the glass in the process), and placed the jar on the studio table. I used an old
coffee jar, as its flat sideswould helpme to control the reflections.

2I setmy camera up on a tripod, attached a remote release and plugged the
lights in (I usedPocketWizards to trigger them, but a sync leadwould have

worked just aswell). I turned the lights on andmade sure theywere positioned to
light the subject nicely, whilstminimising the reflections on the jar. I then
checkedmy focus, and locked it by switching the lens toMFmode.

3I setmy camera’sWhite Balance to Flash (set it to Tungsten if you’re shooting
with lamps), and the exposuremode toManual. I set the shutter speed to

sync at 1/125sec and then took a flash exposure reading and adjusted the power
of the light to giveme aworking aperture of f/10, whichwould provide sufficient
depth-of-field. A test shot confirmed a good exposure.

LIGHTING: I used a studio table formy shots, but if you don’t
have one, any table would work, with a white sheet, or some
thick paper placed over it. For the background, a sheet of white
card works just fine (though formore unusual results, you could
also try coloured backgrounds). I used two Interfit studioflash
lights, although any basic studioflash or continuous lighting
system is suitable One light was aimed at the white background,
tomake sure that it lookedwhite in the shot, rather than a dull
grey colour. This would also bounce the light back onto the
subject, giving the fruit a translucent glow. The other light was
positioned over the jar, to light the subject. I then carefully
adjusted the position of the lights and the jar, tominimise the
reflections that appeared on the front of the jar.

Techniquewatch

Make sure you clean the glass or jar
thoroughly before you start shooting.
Use very hot water to wash it, let it dry,
and then use a soft cloth or shammy
to remove any driedwatermarks

Keepitclean!eepitclean!
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4The next stepwas to pour the sparklingwater onto the ice.When the jar
was nearly full, I took several shots. Once satisfied, I adjusted the

composition bymoving the tripod slightly. I then refocused and shot a few
more frames, to get a good variety of images. Shooting straight after thewater
was poured gave the best results, as thereweremore bubbles in the shots.

5Thefinal stepwas to transfermy images tomy computer. In Photoshop,
I adjusted the contrast by creating an ‘S curve’ in theCurves tool. Tomake

the bubbles stand outmore, I then applied someUnsharpMask, adjusting the
amounts of sharpness and radius to get the optimal result. I tweaked the
Colour Balance slightly aswell, tomake the colours look ‘punchy'.

Finalimage
Thiswas one ofmy favourite

images from the shoot, as I liked
the position of the fruit, the

translucent effect, caused by the
backlighting, and theway in
which the bubbles have been

captured as they rise to the top.
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3TWEAKINGTHERESULT: Inspect the results of your efforts on your computer
– if it’s not quite the effect you hoped for, you can tweak thingswith a simple

Levels adjustment. In AdobePhotoshop or Elements, choose
Image>Adjustments>Levels and pull the right-handmarker inwards tomake the
backgroundwhiter. Then tweak the left-handmarker to deepen the blacks
somewhat until you’re happywith the effect.

4EXTENDINGYOURCANVAS: Sometimes graphic compositions like this can
benefit from someextrawhite in the composition – known in the trade as

‘negative space’. An easyway to do this iswith the crop tool. Draw round the
whole of the canvaswith it, then use a drag handle to extend the box beyond the
existing image. Hit return and new spacewill be added andfilledwith the
background colour –which in this case should bewhite.

1Setting your camera to an auto exposuremode, or
metering inmanual, straight from the paper, won’t

give you a good result: a camera’smetering aims to
make things 18%grey, not white. Instead, start at your
meter’s indicated exposure inmanual mode and take
pictures while lengthening the shutter speed, watching
the histogram until you can see proper whites at the
right-hand side of the graph.

2With your correct exposure locked-in, usingmanual
mode, bring in your subject, positioning it slightly

away from the background. You'll want to use a shallow
depth-of-field to render the paper out of focus and,
therefore, devoid of any distracting detail. Youmay be
able to hold the grass stemwith one hand and your
camera with the other, but we’d highly recommend a
clamp or vase tomake this stepmuch easier!

SETTINGUP:
A piece of ordinary
A3 copier paper
taped to a
south-facing
windowon a sunny
daywillmake a
great background
for our silhouette
image. Tracing
paperworkswell
under cloudier
conditions. Our
subject is then
placed in front of
the paper.

WATCHYOURTONE!This typeof
image is just begging for some toning
to really set it off. There are somany
waysof doing this. A great option is to
use the split-toning feature in
Photoshop’sCS3’sCameraRaw
conversionplug-in.

Techniquewatch

Create windowlit
fine-artsilhouettes

TIMEREQUIRED
15 MINUTES
EQUIPMENT USED
NIKOND700 & 50MM
F/1.4 STANDARD LENS
ALSO USED
SHEET OFWHITE
PAPER, GRASSES,
THISTLES,
DANDELIONS, ETC

IANFARRELL:Silhouettes
are graphic images that not
only look great but are easy
to produce too. All you need

is a plain background that’s lit more
brightly than the subject in front of it.
As for what to shoot, some subjects
work better than others, so
experimentation is key, but it’s worth
seeking out objects with some
transparency or fine detail in them.
After some trial and error, I found
long grasses to be particularly
suitable. They’re around all through the summer, and grow in large
numbers. The source of your bright background can be as simple
or as complicated as you like. If you have studio lighting, a softbox
makes a great white background. Alternatively, light a sheet
of paper from the rear with a flashgun, or even just tape a piece of
tracing or photocopier paper to a window for a simple but effective
solution.We used the paper-on-window approach for the
photographs you see here. It’s such a simple approach that the
whole thing was done and dusted in 15minutes!
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Finalimage
Asemi-silhouetted approachworks
well for this stemof grass. Thiswas
achieved by notmoving the black

point in Photoshop's Levels
adjustment screen toomuch.
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4When the scanning is complete, open the image
in Photoshop and enlarge it to 100%.Not only

does this show just how impressive the image
quality is, but it will also highlight any dust spots and
blemishes that can be removed using theHealing
Brush tool or Clone Stamp tool.

5Once the image is 'clean', it’s time to put your
imagination and creativity to good use.Make a

copy so you've an unaltered original and then try
things like boosting contrast, converting it to black&
white, toning it or adding filter effects such aDiffuse
Glowor someGaussianBlur.

6For the image shown in this step-by-step, I
converted the original colour scan to black&

white using Image>Adjustments>Black&White in
PhotoshopCS3 then experimentedwith Levels and
Curves before addingDiffuseGlowandGaussian
Blur to an adjustment layer. Easy!

2As the lid of the scanner can’t be loweredwith the object on the platen, you
need tomake your ownD.I.Y. hood to cover it. I use an old box file sprayed

insidewithmatt black paint. By cutting the lid off I was left with a black box 4in
deep, which I placed over the object. Not only does it contain the light from the
scanner, but it also creates a plain black background.

3Open your scanner software and create a preview scan of the object.Make
any adjustments to contrast, exposure and colour balance, then set the

output size of the scan – I chose 16x12in at 300dpi.When you’re all done, click on
SCANand sit back andwait for the scanner to do its job – this usually takes a
couple ofminutes if the output size is reasonably large.

FLATBEDSCANNER:
Flatbed scanners are often
seen as a cheap alternative
to a dedicated film scanner.
However, while most may not
be able to scan film originals
as well as a proper film
scanner, they’re far more
versatile for general use and
every photographer should
own one! The good news
is that you won’t need to
break the bank to buy one.
The Epson Perfection V500
is a budget option and boasts
a resolution of 6400dpi – which means pin-sharp prints measuring
24x20in or more at 300dpi are easily achievable. The V500 is also
the first CCD scanner to use LEDs as a light source so instead of
hanging around for ages while it warms up, just one second after
flicking the ‘On’ switch you’ll be ready to scan.

Essentialkit

Scan a flower with ease
LEEFROST:Fewphotographers realise it, but the humble flatbed scanner is not only good at
scanning flat artwork – you can also use it as a large-format digital scanning camera, to
‘photograph’ 3Dobjects andproduce images of astounding quality. Even a budget-priced scanner
like the EpsonPerfectionV500model used here is capable of resultsway beyond a top-enddigital

SLR. I've been experimentingwith this technique for some timenow, scanning natural objects such as
flowers, seeds, heads and leaves to create beautiful fine-art images. In this technique I'll showyouhow it’s
done, and explain how the original scanned image is just the beginning of a creative adventure.

TIMEREQUIRED
1 HOUR
EQUIPMENT NEEDED
EPSON PERFECTION
V500 SCANNER
ALSO USED
BOXFILE, GERBERA
& PHOTOSHOP CS3

1Thefirst step is to give the platen (the glass plate) a good cleanwith a
microfibre cloth to remove asmuch dust as you can. Thiswill reduce the

amount of spotting you have to do to clean-up the scan.When you’ve done that,
take your chosen object (flowers, leaves and other natural subjects are ideal) and
place it on the platen. Take care not to scratch the platenwith sharp objects.
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Add extra int
erest to

your sca
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by scann
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paper to
create a

texture s
creen, th

en

combine it w
ith themain image and

adjust th
e opacity

of the te
xture scr

een

layer un
til you’re

happyw
ith the effec

t

Tryaddingatexture!
Tryaddingatexture!

Finalimage
Abeautiful image of a

flower capturedwithout the
use of a camera. Isn’t the

digital age amazing!
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Lightin
gLIGHTING PROJECTS

SWITCHONYOUR FLASHGUN, STUDIOFLASHORYOUR FLASHLIGHT FOR IMAGINATIVE RESULTS

Step-by-steptutorials
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Give it aswirl!
HELENSOTIRIADIS:Capturing light trails is
usually an outdoor, night-time activity but it's
just asmuch fun trying indoors, and also
often farmore achievable. All you need is a

dark room in your homeand a strong LED torch for
painting shapes and to illuminate the prop,which is
being added to improve the composition.Most people
try this techniquewithout objects and just spell words
or drawa simple shape, such as a heart or star in the
air, but having something to drawpatterns around–
especially if it’s reflective like a glass – canmake the
image look less humdrumandmuchmore impressive.

TIMEREQUIRED
45MINUTES
TIMEREQUIRED
45MINUTES
EQUIPMENT USED
CANON EOS 40D
WITH CANON EF 50MM
F/1.4 LENS

EQUIPMENT USED
CANON EOS 40D
WITH CANON EF 50MM

ALSO USED
MANFROTTO 190XPROB
TRIPOD, A REMOTE
RELEASE & LED TORCH

ALSO USED

TRIPOD, A REMOTE
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3While the room is still lit, compose the scene and focus on the glass.
If you used autofocus rather thanmanual focus, turn it off before you

switch the lights off or the camera will try unsuccessfully to refocus in the
dark. Set the camera tomanual mode to allow you to vary the shutter speed
and set the aperture to f/22. Turn off the lights and start shooting!

1 I used a water-filled fluted glass for this shot to create refractions of light.
As the light accentuates fingerprints and dust, make sure the glass is clean,

and after filling it, wipe the outside and the inside above the water level to
avoid stray droplets. I used a very strong LED torch, with a cool blue light, but
to bemore creative cover the torch with coloured cellophane.

2The set-up for this image is simple and costs almost nothing. Bend a large
sheet of black construction paper so it leans against a cardboard box,

steadied by the weight of a few books. I used a sheet of dark, tinted glass but
you could use a second piece of card as a base. The cameramust be
completely still for the duration of the shot, somount it onto a tripod.

Finalimage
This shot required very little
post-production. I created an
exposure adjustment layer in
Photoshop (Layer>NewAdjustment
Layer>Exposure), increasing gamma
to darken any hints of light on the
black background and base.
Finally, I used theHealingBrush Tool
to clean up bits of stray dust on the
reflective surface and the glass itself.

WHICHLEDTORCH?
Finding the right LED
torch for this technique
canbe tricky; too large
and your light trails
couldmerge together,
too small and you could
struggle illuminating the
prop. Try to findone
that’s compact and
lightweight so it’s easy to
manoeuvre and gives off
a strong, highly-defined
light beam. Ideally opt
for onewithmultiple
bulbs (the torch used
here has nine) as it will
providemore interesting
swirls, enriching a
potentially bland
composition. The colour
of the light is alsoworth
considering, too.

Essentialkit
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5Initially, I used a five-second exposure but I didn't have enough time to
illuminate the glass from the side with the torch and create enough light

trails. This technique is all about trial and error, so try different shapes and
prolong the shutter speed. I found ten seconds was ideal as it allowed plenty of
time to light the glass and to create pleasing swirls.

4Remember to spend a few seconds shining light on the side of the prop to
illuminate it and to think about the types of shapes youwant to create. My

first few attempts were too high, too sparse or too low (creating an undesirable
reflection in the base) or just the wrong shape. It took a few attempts, but
finally I started getting results I was pleased with.
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DANIELLEZANO:Getting to use just one flashgun
proves a daunting prospect formany, so how does the
thought of using two grab you? This technique deals
with showing you how to light a subject with one

flashgun, while a second flash is used to illuminate the
background. This technique is useful when youwant to highlight
detail in the scene or, as shown here, youwant to use flash gels
to light it in a completely different colour.While thismay sound
difficult, it’s actually quite easy to achieve. You need to use your
camera’s integral flash (or a hotshoe-mounted flashgun) to
illuminate your subject, which is pretty straightforward as the
exposure is taken care of automatically by the camera thanks to the wonders of TTL flash. A
second flashgun is triggered automatically by themain flash to illuminate the background, so
you’ve little to do other than ensure that the remote flash is set up correctly, which as the panel
on the right reveals, is pretty easy to do.

Flash gels are small sheets of coloured plastic that are placed over the flash head to colour
the flash output. The flash gel is held in place over the head via Velcro or an elastic band and
with a number of kits available with a choice of colours, it’s an inexpensive and easy way to add
creative flash effects to your images. Larger flash gel kits are available for studioflash heads too,
so the technique used here can easily be applied to studioflash set-ups as well as flashguns.

Using flash gels to illuminate a background is equally suited to both indoor and outdoor
locations. Plain backdrops as well as textured surfaces are suitable, although the latter does
provide additional visual interest. It’s also worth bearing inmind that you can usemore than
one flashgun for the background, so feel free tomix colour gels.

Addcolourwithflashgels

1Here’s our subject photographed using only our
hotshoe-mounted flashgun. She’s well exposed

but the background is drab and dark.

3We’ve fitted a Lumiquest red gel and the colour
adds interest, but, with the remote flash set to

TTL, its output isn’t as strong as we’d like.

2We’ve set up a remote flashgun behind her,
which fires to light the wall in the background

but the effect isn’t particularly attractive.

4Setting the remote flash tomanual power
provides a far stronger output, although the

full-power (1/1) setting is far too strong.
5We try variousmanual power settings to see

which provides the best result and find that for
the half-power setting works best.

Remoteflashgunset-up

WAYSTOTRIGGERAREMOTEFLASHGUN:
Depending on the types of flashgun and
accessories you are using, there are a number
of ways of triggering your remote ‘gelled’
flash. If you have a dedicated flashgunwith
a slave function, you can use theMaster/
Slave facility to trigger it when you release
the shutter. You’ll need to refer to your
camera/flashgun instructions as this varies
according to the camera/flash brand and
mode. Alternatively, you can fit a slave cell
to the bottom of any flashgun, which is then
triggered by the output from the camera’s
built-in or hotshoe-mounted flashgun
(depending onwhich you are using).

SETTINGUPTHEEXPOSUREONTHE
REMOTEFLASHGUN: If you’re using adedicated
Master/Slaveflash system to trigger the off-
cameraflashgun, then you caneither set up its
output to bebasedonaTTLexposure ormanual
power setting.While selectingTTL is normally
thebest choice,we’d actually recommendyou
set theflash tomanual for this technique, as
the resultswill bemore consistent. If you are
using a slaveflash, you should set theflashgun
tomanual to allowyou to set a specificpower
setting.With theflash inmanual, you can set the
remoteflash tofire at fixedpower settings such
as full power (1/1), half power (1/2), quarter
power (1/4) and soon. Take some test shots
andadjust thepower settings to suit the scene.
Adjust power if youwant a stronger orweaker
effect or if you switch colour gels, as some
absorbmore light thanothers.

TIMEREQUIRED
30MINUTES
EQUIPMENT USED
CANON EOS 500D&
SPEEDLITE 580EX
ALSO USED
COLOUREDGELS
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Finalimage
While the red gel is attractive,

it proves overpowering, so
we try various colours and
find greenworks the best.



1Oncemy subject
had arrived, I

showed himmy test
shots, so that he
would understand
whatwewere
trying to achieve.
I then got him to
stand in position,
and asked his father
to stand in the ‘devil’
position behind the
screen. Thiswould
helpmewithmy
composition, and also
make the ‘angel’
easier to cut out in
Photoshop later. I
then took some
shots of the ‘angel’
fromvarious heights
and reviewed them
onmy camera.

2Having captured a
good shot of the

child smiling, I asked
him to put on the
devil horns and hold
the trident, and to
stand on the chair
behind the paper
background. His
motherwas also
there tomake sure he
didn’t fall or injure
himself. I checked the
first shot onmy
camera’s LCD screen,
andmade sure that
everythingwas
exactly right, such as
the angle of the
windmill/trident and
the position of his
hands, etc. I then took
the ‘devil’ shot.

SETTINGUP:Small children can
get bored very quickly if they’re just
standing aroundwaiting, so I decided
to practise this technique before
my subject arrived. I placed one
studio light behind thewhite paper
background, pointing roughly atwhere
I wanted the ‘devil’ shadow to appear.
I then set a stool between the two for
the subject to stand on. I placed a
second studioflash head – this time
with a softbox attached – off to the side
where I wanted the ‘angel’ to stand. I
then asked two colleagues to stand in
place and took a series of test shots
until I was happywithmy exposure.
The backlightwas on full power, while
the light at the front, fittedwith a
softbox, was set to around 1/3 power.
Next, I switchedmyDSLR tomanual
exposuremode, setting the shutter
to itsmaximumflash sync speed of
1/60sec and an aperture of f/22.

Turn your little angel intoadevil
STEWARTBYWATER:A technique that I’vewanted to try for quite a long time is to take
a photographwhere the subject’s shadow appears to be different from the subject that
has cast it. I’ve seen this done a number of times, and oftenwondered how it was
executed. There are several ways inwhich it could be done,most involving very clever

lighting techniques and an understanding of scale and trajectory. This seemed somewhat
over-complicated, so I tried to think of a simpler way of doing it. In the end, I decided to shoot two
exposures using awhite paper studio backdrop, with one light placed in front of it and one light
behind. For the 'shadow' exposure I would place the subject behind the paper, as it was thin
enough to let his shadow show through, yet thick enough so that it would not be completely
transparent. For the portrait image, I placed him in front of the paper. I would latermerge the two
in Photoshop. However, it's worth pointing out that if you had two people of roughly the same
build, whowould project a similar silhouette, you could get the result with a single shot.

TIMEREQUIRED
ONEHOUR

EQUIPMENT
CANON EOS 10DWITH
17-40MM LENS, TWO
INTERFIT STUDIOFLASH
HEADS, POCKETWIZARDS,
LASTOLITEWHITE STUDIO
BACKGROUND PAPER ROLL

ALSO USED
DEVIL PROPS &WINDMILL

STUDIOFLASHLIGHTS
While this technique could be
achievedwithout studioflash,
they domake it a lot easier. The
main reason for this is that you
can adjust each light’s power to
find the perfect balance between
the foreground subject and
back-light. The lights can also be
easilymoved into various
positions until you get the best
results. Studioflash is also a
great option in situationswhere
subjects, such as children,might
move around a lot, aswithmany
newerDSLRs, they can sync up
to 1/250sec, allowing users to
capture their subjects sharply.

Essentialkit
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3Once I had the necessary images, I transferred them tomy computer. After
spending a short time selecting two ideal frames – one of the shadow, the

other of the subject – I opened themboth up in Photoshop. I then used
Image>Adjustments>Levels (Ctrl+L) andmoved thewhite slider to the left until
the backgroundwas almost purewhite. Then, using theMagicWand, I set the
Tolerance to ten (pixels) and clicked on thewhite background tomake a
selection. I then use Select>Inverse to select the subject.

4Using Edit>Copy (Ctrl+C) Imade a copy of the subject selection and then
closed the file andmoved onto the shadow image. I used Levels here as I did

on the other image to achieve a clearwhite background, then, using Edit>Paste
(Ctrl+V) I placed the copied selection onto the shadow shot. You canmove the
subject by holding theCtrl key andmoving themouse and, using Edit>Free
Transform (Ctrl+T), resize the subject by dragging any of the corner pointswhile
holding the Shift key to ensure scaling is proportional.

Finalimage
This shot can be done

in-camera. But if you’re
lucky enough to have

almost identical subjects
to hand, you’d be better
off combining two shots.
Eitherway, it’s great fun
andwill leave youwith a

really fun image.
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3WHITEBALANCEAlthough a diffuser can bathe a subject in softer,more
flattering light, it can also alter the colour temperature. As I shot in Raw, the

White Balance can be easily changed later in Photoshop’s AdobeCameraRaw.
I therefore took a photo ofme holding awhite piece of paper, which I could later
use to set theWhite Balance onmy computer.

1HAIR LIGHT I set a standard table lamp,without its shade, between the
backdrop and the stool – ensuring the lightwas directly behindmyhead and

far enough away from the backdrop so not to illuminate it. For optimumhighlights,
make sure the bulb is level with your head. Use a fan, or have a friend flap a
magazine, to lift the hair and add drama to the image.

4 INTERVALSETTINGThe interval timer is a hidden gemon theNikonD300.
I used it instead of the self-timer as it allowedme to shoot continuous frames at

set intervals. A remote triggerwould have similar benefits, but the interval timer also
adjusts the exposure, focus andmetering before each shot. There is a lot of trial and
error involved in this technique, so be patient and take lots of shots.

2EXPOSUREAlthough Iwas shooting a head and shoulders portrait, I framed it so
therewas plenty of room to crop later in Photoshop. I then set the camera to

aperture-prioritymode at f/2.8 to get a shallowdepth-of-field. Having a largemirror
placed beside the cameramay help you to gauge how the composition looks before
it’s taken, but I took a few test shots first to assess the framing and focusing.

Homestudioself-portrait Essentialkit:Diffuser
In the sameway a reflector can fill in shadows or
addwarmth to a subject’s face, a diffuser can
soften the strong effects of artificial light –
producing amore flattering result.Whether you
can get your hands on a diffuser, or an equally
effective alternative, such as grease-proof paper, it’s
worth bearing inmind that not onlywill it reduce the
amount of light that reaches the camera, butwill often
alter theWhiteBalance too. Normally thiswon’t pose a problem if you’re
shooting inRaw, as the colour temperature can be easily reset once you
have the images on your computer, but if not theWhiteBalance needs to be
changed in-camera to compensate for the lighting conditions.

TIMEREQUIRED
60MINUTES

ALSOUSED
TWOHOUSEHOLD
LAMPS&AHANDHELD
DIFFUSER

EQUIPMENT NEEDED
NIKOND300, 50MM
LENS&MANFROTTO
055B TRIPOD

CAROLINEWILKINSON:
Studio photography canbe
an expensive, and daunting,
areaof photography to test

drive, but often the simplest set-ups
prove tobe thebest.Here, I’ll showyou
how to create anattractive hair light
using a table lamp, but youcanalsouse
wireless flashgunsor a studioflash kit.
A hair light is a flattering technique

for portraits, createdbya strong
directional light behind the subject’s
head,whichproduces a soft luminous
highlight around thehair. If your subject has short hair, directing the
light source at themiddle of theheadcancreate a subtle halo effect.
Whereas, for subjectswith longor curly hair, amoredramatic effect can
beachievedbypositioning the light at thebaseof thehead so it diffuses
throughmoreof thehair. It's alsoworth experimentingwith theposition
of themain light, in this case a second table lamp, to controlwhere the
shadows fall on the face. A reflectorwill alsohelpwith this.
I chose to do this technique as a self-portrait. Unfortunately the one

personmost photographers shoot the least is themselves,but
self-portraits are an idealway to test lighting and creative techniques.
Plus it’s easier than youmight think!

SET-UP: I decided to use
ablack backdrop for this
shot tomake the effect
of the hair light standout
asmuchas possible. I
positionedmymain light
source, a tungsten desk
lamp, off to the side and
high up. If this light is too
harsh, consider using a
diffuser (or a homemade
equivalent) to soften it.
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Finalimage
Using the fan added

much needed interest to
the image. I left the

colours as theywere as
I liked how thewarmth of
the glow complemented

the soft lighting and
shallowdepth-of-field.
However, for a different

look you could try
converting it tomono.
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5With the reflector correctly placed and the
camera settings spot on, I'm at last happywith

my lighting.While everything isworkingwell, I ask
Sophie to try out somedifferent poses and angles
and capture a number of shots.

4With a newaperture of f/9, I’ve finally got the
correct settings, but this time the reflector has

slipped and failed to bounce the light in the right
direction. You can see from this imagewhat a
difference the reflectormakes.

6Once I’ve uploaded the correctly exposed image
tomy computer, I use the Levels slider to

increase the brightness of the skin tone. Lastly, I
adjust the Saturation slider to decrease the colour
slightly before savingmyfile.

2You’ll need to fire off a couple of test shots to
fine-tune your settings. I opted to start with an

exposure of 1/125sec at f/11 (ISO200), butmyfirst
attempt is a tad on the dark side, losing that bright
high-key effect. This is due to slight underexposure,
which I can correct by using awider aperture.

3I look again atmy settings and select an aperture
of f/8. Unfortunately, this time the image is too

bright and themodel’s face has burnt out in places,
leading to unsightlywhite areas on her skin. Imay be
able to rescue someof the detail in Photoshop, but
areas that are toowhite are beyond repair.

1Myfirst jobwas to arrange the lights aroundmymodel, Sophie. I used one
studioflash and softbox to light thewhitewall. By overexposing the

background, it prevents the light illuminating the subject fromcreating shadows
on thewall. My second head, fittedwith a brolly, was placed to the front right of
Sophie. Finally, I rested a reflector on her knees to bounce light under her chin.

Bright and beautiful portraits
PAULWARD:High-key
portraits refer toshots
leaningheavily towards
thehighlights, limiting

anyshadows, forabright,
light-lookingportrait. It'sa
popular technique,adoptedby
manyhigh-streetstudios,
possiblybecause it'ssoeasy to
shootand, ifneeded, topost-process, togetpolished,
professional-lookingresults.As aminimum, use two light
sources; one to illuminate the subject's face and another to
overexpose the background. A homebudget studio kit is
perfect but, although it's a little trickier, you could try standing
your subject in front of a sun-drenchedwindowand
illuminating the facewith a flashgun.However, luckily, the
price of studioflash has tumbled in recent years and it’s now
possible to buy a studioflash kit (with twoflashes, brolly and
softbox) for under £200 if you shop around. I used the Jessops
Portaflash kit for these shots. It’s also important to get the
backdrop right: although it’s preferable to use a flat, white
surface like awall or awhite roll of backgroundpaper, you can
also get by using just awhite bedsheet as long as it's pulled
tight to reduce any shadows causedbywrinkles or creases.

REFLECTOR:
Aswell as the studioflash
kit, I alsomadeuseof a
large reflector. If youdon’t
have a reflector to hand,
you can improviseby
using a roll of tin foil, or if
you’re really stuck, a large
mirror. That said,
reflectors are so cheap
now that youcanpick one
up for less than£20.Choose
one that comeswith a silver
finish, or better still, onewith a silver andgold
reversible sleeve for extra lightingoptions.

Essentialkit

TIMEREQUIRED
45MINUTES
EQUIPMENT USED
70-200MM LENS,
JESSOPS PORTAFLASH
KIT & SILVER REFLECTOR
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Finalimage
In under an hour you can

produce a quality, high-key
shot that brings striking
impact to your portraits.
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5 I scooped out the insides of some kiwi fruit and then carefully placed the
juicy results aroundmy fruit slices. I decided tomake a slice of applemy

key focal point, as this had themost interesting and recognisable outline. I
used the slices of citrus fruit to balance the composition. However, I felt I
needed to add a splash of red to contrast with the greens and yellows that
dominated the image for extra punch.

4 In order to add some needed colour, I switched to citrus fruits, using a slice
each of orange, lemon and lime. I liked the contrasting colours and sizes of

the fruit. I arranged them so that their edgesmet and the backlighting really
emphasised their form and transparency. However, the white gaps between the
fruit were distracting and didn't make the best composition, so I decided I
needed to fill the entire framewith colour.

3 I checked the histogram,which confirmed the photowas underexposed, so I
applied positive (+) exposure compensation of 2/3EV. This remedied the

problemand the subsequent imagewas exposed correctly. However, the image
lacks colour and impact. This type of shot evolves as you go along.
Experimentation is the key, so I decided to try somedifferent fruits.

2 I placed slices of apple, pear and grape on the lightbox. I took time to arrange
themso they created a pleasing composition. I tried to fill the image space

with the fruit, avoiding large empty spaces thatmight prove distracting.When
happy, I tookmyfirst shot. However, backlighting can often fool TTLmetering
into slight underexposure and the image is too dark.

1 I returned from
the local grocers

with an assortment
of fruit including
apples, pears, an
orange, a lemon and
a lime, grapes and
a pomegranate. I
wanted to highlight
their shape and
form, therefore I
carefully cut each
one into thin slices to
create a photogenic,
translucent cross-
section of each fruit,
ready to arrange on
my lightbox.

Look at fruitsalad with fresh eyes!
ROSSHODDINOTT:Ourhomesare full ofpotentialpictures, you justneed to lookateveryday
objectswitha fresh, creativeeye.Small objectsare theeasiest to illuminatecreatively, allowing
youplentyofcontrolover the typeof lighting–naturalorartificial–andalso itsdirection.Oneof
my favourite formsof light isbacklighting.Translucentsubjects, likecolouredplastics, glassand

leaves lookparticularlyattractiveandeye-catchingwhenbacklit. Theeasiestway tocreate this typeof
lighting indoors is tousea lightbox.Manydigital convertswill alreadyhaveone fromtheirdaysof viewing
slides.However, if youdon’townone, theyare relativelycheap tobuyormake.All youhave todonow is
findasuitablesubject toshoot. Food isaparticularlygoodstill-life subject, especially fruit,with itsbright
coloursandvarietyof textures. Iwasmaking the familya fruit saladoneeveningwhen inspirationstruck.

TIMETAKEN
45MINUTES
EQUIPMENT USED
NIKOND700, SIGMA
150MMMACRO
LENS& TRIPOD
ALSO USED
LIGHTBOX&VARIOUS
TYPESOFFRUITS

OPTIMISEDEPTH-OF-FIELD:
Whenyou’re taking close-ups from
overhead, optimisedepth-of-fieldby
keeping the camera’s sensor plane–
markedon the camerabody–parallel
to the subject. Bydoing so, youwill
keepall objects of similar height in
focus. If the camera is at anangle to
the subject, areasof itwill drift
out-of-focus, spoiling the crisp, fresh
lookof the fruit and lessening the
impact of the shot.

LIGHTBOX: Backlighting small
translucent objects indoors is
easywith the help of a lightbox.
They are available in a variety of
sizes, but A4 size or larger is
probably themost versatile and
useful. The lightbox canbe
placed on a tabletop or on the
floor, then,with the help of a
tripod, position your camera
overhead. A lightbox can also
create striking silhouettes of
small, solid objects.

EssentialkitTechniquewatch
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Finalimage
I carefully removed the bright red
seeds of a pomegranate and used
them to replace the kiwi fruit.
This added the colour contrast
and impact the previous shots
had lacked. A vertical composition
worked best. The result – a simple
but striking still-life taken in the
comfort of indoors. And, the left-over
fruitmade for a delicious fruit salad!
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1Thefirst thing you need to do is to set up your camera securely on a tripod.
For this shot, I neededmy camera to point directly down,whichwas easywith

theManfrotto, as the centre column can be set horizontallywith ease. SetManual
exposuremode, an aperture of f/8 or f/11 for optimumsharpness and a starting
exposure time of between four and eight seconds.

2Compose the image using the viewfinder (or LiveView) and focus on the
subject. Once you’ve focused, switch the lens fromAF tomanual focus,

becausewhen you switch off the room lights, your camerawon’t be able to focus
in the dark. So long as you don’t zoom the lens ormove the camera (or subject),
the image should stay correctly focused – but check this regularly!

TRIPOD:A tripod is an absolutely
essential accessory, as you'll be
taking long exposures, running
into seconds. Any tripod that
offers a stable platform is
suitable, but if you want to
have your camera pointing
downwards, as I had, one
with a centre column
that an be positioned
horizontally is ideal.
I used the Manfrotto
190XProB, which
features an ingenious
centre column that can
be switched from vertical to
horizontal without having
to remove it. Any modest
digital camera kit is suitable
– I used a Nikon D60 with
an 18-55mm lens.

Essentialkit

Paint asubject with torchlight
DANIEL LEZANO:Painting by light involves using a long exposure and illuminating your
subjectwith a torch (or any other light source for thatmatter). It’s a simple technique that can
be used to light a variety of subjects, butworks particularlywell with still-lifes. The idea is that
youmust shoot the subject in complete darkness, so that the only light that illuminates your

subject comes from the torch. For this step-by-step, a bowl of appleswas used to illustrate the technique.
The key thing is preparation – set up your equipment correctly and you’ll quicklymaster this technique.
As you can see from the shots below, you only needminimal kit to give it a go, so it's something that you
should be able to trywhen younext have a bit of spare time in the evening. One useful bit of advice – \
set up near a light switch so youdon't have tomove around toomuch in the dark!

PAINTINGWITHLIGHT
Sohowexactly do you
paintwith light? It's pretty
simple really. During the
exposure you simply bathe
your subjectwith light,
moving the beamaround
at different angles and
speeds. If you hold the
beamover a certain area
for a prolongedperiod, it
will appear lighter than
areaswithminimal
exposure, while changing
the angle also creates
different effects. It's all
about trial and error, and
every image is different,
but it's good fun and
produces great results.

Bulb

LED

Techniquewatch

TIMEREQUIRED
20MINUTES
EQUIPMENT NEEDED
NIKOND60WITH
18-55MM LENS
MANFROTTO 190X
TRIPOD& TORCH
ALSO USED
FRUIT & BOWL
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3Switch off the room light and get into position. Press the shutter button and
move the torch in randomdirections and angles to paint your subjectwith

light. Once the exposure has ended, check the preview and adjust the exposure
by changing the shutter speed in full stops (i.e. halve or double it) depending on
whether the image is too dark or light for your liking.

4By changing the angles fromwhich you light the subject, and the amount of
time you spend lighting different areas, you’ll be able to produce very

different results. Experimentwith fast random torchmovements ormore
controlled paths of light. You’ll also find that a normal torch gives awarm,
orange cast, while an LED torch gives a brighter andwhiter effect, so try both!

Finalimage
Thiswasmy favourite from the

20 or so images I shot. Very
little Photoshopworkwas

needed, other than to crop the
image into a square format and

to adjust the Levels slightly.

Maglite LED



THE IDEALCOMPANION FORYOUR DIGITALCAMERA

MagBookscoverarangeoftopics,fromITtoMotoring,andFitnesstoLifestyle

Orderyourprintordigitalcopydirectfrommagbooks.comorcall08448440053
ONSALE NOW!



P
hotoshop

O
utdoor

Indoor
Creative

Creativeprojects 10350PHOTOPROJECTS

Lightin
gCREATIVE PROJECTS

IMPROVE YOURPHOTOSKILLSWHILE CAPTURING INVENTIVE AND IMAGINATIVE IMAGES
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Shootsilh
ROSSHODDINOTT
striving for the ‘corr
it could be argued
greatly depends on

effect the photographerwan
silhouette can create a truly
technically-speaking, it is the
A silhouette iswhen the

outline, without colour or de
– in otherwords, the subject
most extreme formof backligh
the right scene or subject, the
particularlywhen the subject
interesting or colourful sky
colour, silhouettes can con
prove that there really is no
Oneof the great things about

they are easily achieved and
visitedDartmoor’swindsw
shoot perfect silhouettes…
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TIMEREQUIRED
30MINUTES
TIMEREQUIRED
30MINUTES
EQUIPMENT USED
NIKOND300WITH
SIGMA150MMMACRO
TRIPOD&REMOTE

EQUIPMENT USED

SIGMA150MMMACRO

ALSO USED
PRE-FROZENLEAF
ALSO USED

Createawinteryclose-up
ROSSHODDINOTT:Ourwinters are growing increasinglymild,making itmore and
more difficult to capture greatwintery images. Evenwhen there is a hard frost, there is
no guarantee youwill be able to capture the glisteningwinterwonderland outside, as
youmaybeworking or doing the school run. However, rather than getting frustrated

at the lack of opportunities to shoot close-ups of frost and ice, why not create your ownby
freezing objects in your fridge-freezer. You could freeze practically anything, but feathers and
leaveswork particularlywell. Other than your camera set-up, all you need is your chosen
subject, a large (freezable) Pyrex dish, somewater, a few spareminutes and a little creativity…



silhouettes
HODDINOTT:Asphotographers, we are always

the ‘correct’ exposure, aren’t we?However,
argued that there is no such thing; as it

depends on the subject, the situation, and the
apherwants to achieve. For example, a

a truly eye-catching image even though,
it is the result of a poor exposure…

when the subject is recorded as a black
olour or detail, against a lighter background

subject is grossly underexposed. It is the
backlighting but, when combinedwith

subject, the results can be stunning –
subject is contrasted against an

olourful sky. Despite the lack of detail and
an conveymuch about the subject and they

ally is no such thing as a ‘correct exposure’.
things about shooting silhouettes is that

ed and youneed very little in termsof kit. I
windswept landscape to showyouhow to
ttes…
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MACROLENSOR
CLOSE-UPFILTER?
A lens that can focus relatively
close is ideal for taking
frame-filling shots of your
frozen object. In this instance,
I opted for amacro lens, but
the tele-end of a standard
zoomshould prove fine if you
are photographing a large
subject, like amaple or
sycamore leaf. However, if you
still need to get closer,
consider using an inexpensive
close-up filter. A+3dioptre
should be fine,with versions
fromHoya andKood available
for around£10-£15. To
maximise imagequalitywhen
using a close-up filter, select a
mid-range aperture in the
region of f/8-f/11.

1First, you'll need tofindasuitable subject. Leavesare themostobvioussubject
to freeze,beingsomething thatyoumightfindnaturally frozen inapuddle, or

theedgeofa lakeat this timeofyear.Amaple leaf caughtmyeye, thanks to its
colourand interestingshape.However, youmaywell haveother ideas, and just
aboutanythingwillwork, froma feather toapinecone.

2Poursomewater intoyourdishandplace it in the freezer–ensuring it is lying
flat so that it freezesevenly.Carefullyplaceyoursubject centrally in thewater

– if it freezes toonear theedge, itwill restrict yourcomposition.Once thewater’s
frozen, adda littlewarmwaterand refreeze.Thiswill helpcreatecracksandair
bubbles in the ice, adding interest toyourfinal shot.

SETTINGUP(ABOVE&RIGHT):
Positioning your camera above
the frozen leaf enables you to
shoot it on the ground froma
sturdy position, while taking full
advantage of the natural light.
The bright, reflective ice fooled
myTTLmetering system into
underexposing the image, so I
had to dial in a +1 stop exposure
compensation to getmy result.

When shooting static, flat subjects,
your shutter speed is immaterial –
as long as you have a sturdy support.
Instead, aperture should be your
priority. For this shot, you only need
moderate depth-of-field, so f/11 is ideal

Depth-of-field
Depth-of-field

Essentialkit
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3Once thewater has frozen, you canbegin snapping. You could shoot it
indoors, using a lightbox to backlight it; but I opted to take it outside, so I

could use the softness andwarmthof the natural light. Using a tripod, I positioned
mycamera overhead, composedmyshot and released the shutter. However, the
brightly-lit ice fooledmymetering system into underexposure.

4To rectify the problem, I knew I needed to apply a degree of exposure
compensation.AswithmostDSLRs,mycamerahas adedicated exposure

compensation facility. Using this, I selected a compensation of +1 stop. I took
another photo and, having studied the result (and corresponding histogram)on
mycamera’s LCD, I knew that the exposurewasnowcorrect.

Finalimage
Ice thaws quickly under direct

sunlight, sowork quickly.With the
exposure now correct, try different
compositions. I tried horizontal and
vertical formats, andwent in close
to isolate specific detail aswell as

including the leaf in its entirety.
Aftermuch experimenting, I settled

on this shot. The end result is a
creative, wintery close-up that you

could take at any time of year!
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TIMEREQUIRED
TENMINUTES
EQUIPMENT USED
NIKOND700WITH
50MM LENS, MANFROTTO
055MF4 TRIPODWITH
RC322 HEAD, BOWENS
TWIN HEAD STUDIOFLASH

3With the lighting
and exposure

sorted, it was time to
position themodels
so that the imagewas
as realistic as
possible. The key area
I had to keep an eye
onwas getting the
head's height correct
so that the arms
looked natural and not
stretched out. It was
also important to have
the hands positioned
so that they appear to
be holding up the
head, as well as also
covering up asmuch
of the neck area as
possible. I asked
Hayley to keep her
chin up so that her
neck is stretched out.
Once I was happy with
the set-up, I fired off a
few different images,
getting Hayley to
adjust her hands to
find the best position.

4TIME FORPHOTOSHOPWork is needed to remove the visible neckline and
detail from the T-shirt. For the neckline, using the Polygonal Lasso Tool, I

make a selection around the neckline area. Now I select the Paint Brush Tool
and, while holding down the Alt key, click on an area of black, which selects that
colour, and begin to paint out the skin. Tomerge the dress and T-shirt detaiI, I
go to Layer>NewAdjustment Layer>Selective Color, creating a new layer and
preserving the original image. I select Blacks in the drop-downmenu, then
move the Black slider until all the detail hasmerged. Finally, using the Erase
Tool, I delete any areas where wanted detail has been lost, such as the face and
arms, restoring detail still preserved on the layer beneath.

1The best way
to calculate the

exposure is to use a
handheld flashmeter,
taking readings from
the neck of the 'torso'
and the face of the
'head', adjusting the
power of each
studioflash light so
that both have the
same exposure. For
those without a flash
meter, the simplest
way is, with your
camera set tomanual
exposuremode, put
the shutter speed to
the flash sync speed,
choose a small
aperture (in this case
f/8) and take a
picture, then review
the image on the
LCD. This first test
shot was grossly
overexposed.

2FINE-TUNE THE EXPOSURE To adjust the exposure, you can open or close
down the aperture, change the ISO rating and/or adjust the power of the

studioflash (do this by changing the power values and/ormoving it closer or
further away from the subject). I kept ISO 320, set the aperture to f/16, then
lowered the power of both flashheads, taking care to keep the ratio of both the
same. A couplemore test shots andminor adjustments to the power gave a
decent exposure, which I confirmed by checking the histogram.

SETTINGUP: There was no glamorous location for this portrait shoot, just the
inside of a garage! The subjects, Hayley (the headless torso) and Katie (the head)
were placed ametre or so from the white garage wall, with Hayley standing and
Katie sat on top of a couple of sofa cushions. Both had been asked to wear black,
as this would help withmerging the two figures together to give the impression of
a floating head. The windows of the garage had to be blocked off with parcel paper
tominimise ambient light. For this image to work, I had to illuminate Hayley's neck
and torso with one flashhead and Katie's headwith the other. I fitted the softbox
to the 500W studioflash and, with it at Hayley's head height, tilted it upwards
slightly to reduce the amount of light reaching Katie's head. I fitted a spill to the
250Wflash and placed this low and close to Katie, so that the light was
concentrated on her head, with as little lighting as possible on her shoulders. A
snoot or spotlight would have been a better option, but I lacked both. You can see
the optimumposition of the lights on the image on the right.

Studioflash
lightingoutfit
I could have used ambient light
coming through the garage door
andwindows to lightmy subjects.
But, I wanted to prevent asmuch
light as possible from landing on
the ‘head’model’s shoulders, so I
neededmore control over the
light’s direction. For this reason, I
used two studioflash heads, one
with a small softbox for a relatively
wide, even spread of light, and the
otherwith a small spill, which
provided a narrow focus of light.

DANIELLEZANO:There are numerous reasons for taking
pictures, but sometimes you should do it just because it’s
fun.With this inmind, I decided to recreate an image I’d seen
in amagazine that showed a headless body holding a head

under one arm. It was quite a high-end image, so there was plenty of
Photoshop involved tomake it appear realistic, but I wanted to shoot a
farmore attainable image for anyonewanting to recreate a similar
shot without having to spend ages in post-production.While this
image does include a little Photoshopwork, the emphasis is on
careful composition and lighting to give the impression that there’s
only one person in the frame, and that they’re holding their own head!

Isn’tittimeyoulostyourhead?
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Finalimage
And therewe have it! An image
that appears to showa headless
torso holding a head.Why not try
something similarwithmembers
of your family comeHalloween!



P
ho

to
sh

op
O

ut
do

or
In

do
or

Li
gh

ti
n

g
Cr

ea
ti

ve
110 Cross-polarisation 50PHOTOPROJECTS



P
hotoshop

O
utdoor

Indoor
Creative

Cross-polarisation 11150PHOTOPROJECTS

Lightin
g

Make plastic fantastic!
DANIEL LEZANO:Cross-polarisation is a
great technique to try at homeas it's a
relatively simple one to do. The idea is to
'sandwich' plastic objects betweenpolarising

material, to reveal stress patternswithin the plastic as
a kaleidoscopic feast ofwonderful colours. It's a great
way of creating extraordinary images of very ordinary
subjects – in this case someclear plastic cutlery that
I picked up at the local supermarket for £1! As you'll
need to shoot in a darkened room, it's a technique you
can try in the comfort of your ownhomeat night.

TIMEREQUIRED
15 MINUTES
EQUIPMENT NEEDED
CANON EOS 400D
100MMMACRO LENS
MANFROTTO TRIPOD
LIGHTBOX, POLARISING
GEL & POLARISING FILTER
ALSO USED
PLASTIC CUTLERY
LENS CLEANING CLOTH
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1Cross-polarisation is all about revealing stress fractures in plastic, so colours
will play a very strong part in the success of the final image. However, equally

important is the shape of the subject you choose, whichwill add extra interest to
the composition. Choosing subjectswith very defined outlines reallyworks – for
this step-by-step, I decided to shoot a cutlery set.

2It's worth jotting down a list of set-ups before you start and add to it as you
go along – as you'll discover, once you start, you'll be changing the

arrangement of objects, zooming in and out (or raising the tripod up and down)
as you think up newangles to try. Start off with a simple composition like this
and bemore creative as you get the hang of things.

3Once you've set up the composition, look through the viewfinder (or better
still use LiveView) and rotate the ring of the circular polarising filter. As if by

magic, you'll see the background change fromwhite to black and colours
transformyour plastic subjects. Stop turning the ring once you've a solid black
background and themost intense colours and shoot away!

TRIPOD, LIGHTBOX & CLOTH!
I used a macro lens to get in
really close to small areas of
my subject, but the tele-end
of a standard zoom would be
suitable too. You’ll need to use a
tripod, as exposures will run into
seconds, so a remote release
is useful too, though I used the
self-timer and mirror lock-up
facility of my Canon EOS 400D
to minimise shake. A lightbox
provides all the light you’ll need
and, apart from the polarisers,
you’re almost there. One extra
bit of kit I’d recommend is a
lens cloth and/or blower brush.
Smears and dust will be obvious
at such magnification!
Use aperture-priority mode, start
at f/8 for optimum sharpness,
but feel free to change the
aperture, to vary depth-of-field.
Multi-zone metering will work
here, but apply exposure
compensation if needed.

Essentialkit

CROSS-POLARISATION
This technique involves placing a
plastic subject between two
polarisers. The easiestway to do
this is to have a circular polarising
filter attached to your lens and
then have another polariser resting
on a lightbox, with the plastic
object(s) on top. You can use
another screw-in polarising filter
on the lightbox, but it limits the size
of the subject you can use. A better
alternative is to buy a sheet of
polarising gel, which covers the
whole lightbox surface. They’re a
little pricy in theUK, butwe’ve
been told by readers of an internet
firm in the Far East (www.3dlens.
com) that offers a goodquality,
affordable option.

Techniquewatch

If your DSLR has a LiveView facility,

make sure to use it when adjusting

objects on a lightbox. Itmakes changes

to composition far quicker and easier

than looking through the viewfinder

LiveViewisabighelp!

LiveViewisabighelp!
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5Despite trying to keep the cutlery as clean as possible, therewas noway
of preventing dust and fluff, floating through the air, from settling on it. It's

worth doing a quick clean every couple ofminutes as it's a far quicker option
than having to remove dust and debris in Photoshop. The problem is
accentuatedwhen you start shootingmacro close-ups such as this.

4As Iwent throughmy list of shots, I started to concentratemore on the
fork and the knife, as their distinct shapesmade them farmore photogenic

than the spoon. Aswell as shooting fromdirectly above the lightbox, I then
tried lowering the tripod and shooting froman angle. I also tried using awide
aperture to reduce depth-of-field to varymy effects.

Finalimage
The image on the opening spread is
my favourite, but this one runs it a

close second. Thewhole shoot only
took 30minutes to set up and shoot
and Imanaged several images I'm
happywith. Do it yourself and I'm
sure you'll have similar success.
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1Thefirst thing you need to do is
to find a suitable scene. Ideally,

the location you choose should have
somewell-defined shapes and areas
of strong shadows and bright
highlights, such aswoodland.
However, this colourful field of
poppies caughtmy eye and I hoped
to be able to use theVaseline to
create a strong abstract effect based
around the bold reds. Imountedmy
DSLRon a tripod, to ensure images
were shake-free, and usedSigma's
excellent 70-200mm f/2.8 lens to
crop fairly tightly on the poppy field.

2With the camera supported on a sturdy tripod, it's important to 'lock' the
focus before smearing the filterwith Vaseline – theAF systemwill struggle to

focus once it's been applied. To do this, focus on the scene normally and then
switch the lens fromAF tomanual focus, sowhen you press the shutter button
later on, to take a shot, it won't affect the focusing.

3With everything prepared, it's time to apply theVaseline. Rather than scoop
bigwedges from the tub, gently smear relatively thin lines of Vaseline across

the frame. Here, you can see how just a single smear affects the scene. I looked
through the viewfinder thewhole time Iwas applying theVaseline, to see how it
was affecting the overall scene.

TIMEREQUIRED
30MINUTES
EQUIPMENT NEEDED
CANONEOS400D
SIGMA70-200MMLENS
MANFROTTOTRIPOD
UVFILTER, LENSCLOTH
ALSO USED
POTOFVASELINE

APPLYINGVASELINE:Asyou’ll
discover, getting adesired effect
requires lots of trial anderrorwhen it
comes to smearing thefilter. Start off
by applying a thin line of Vaseline
across the central part of thefilter,
andapply further smears until you’ve
covered thewhole surface. Takea few
shots, rotate thefilter so the smears
arediagonal and shoot again. Apply
thicker smears of Vaseline to create
randompatterns, and thenwipe the
filter cleanand try again!

Techniquewatch

FILTER,VASELINE&CLOTH:
This is a very affordable
technique. A tub of Vaseline
won’t break the bank, but you’ll
need aUVor skylight filter to
screwonto the front of your
lens. I cannot over-emphasise
how important it is that you
apply Vaseline to the filter and
not to the front element of your
lens, as it could permanently
damage the optics. You should
also keep a clean lens cloth
handy, forwiping away
Vaselinewhen youwant to
clean the filter and try again, or
at the endof your day’s
shooting. That’s about all you
need in termsof accessories,
with the exception of a tripod,
whichwill keep your camera
steadywhen you’re preparing
the composition and focusing
on the scene.

Essentialkit
DANIEL LEZANO:
Photoshophasallowedall
sorts ofweird and
wonderful effects tobe

applied to images inpost-
production, but I still prefer to get as
close aspossible to thefinal image
in-camera.Muchof this is because
I’mnot particularly goodwith
Photoshop tobehonest, butmainly
because I actually find it fun (aswell
as occasionally frustrating), to go
‘old-school’ andusemore traditional
photographic techniques to give the results I’m looking for. I’ve
recently started experimentingwithproducingunusual soft-focus
effects by smearingVaseline onafilter. As I discovered, it’s very
easy to try, sowhynot give it a goand seehowyouget on.

Blur your vision!



P
hotoshop

O
utdoor

Indoor
Creative

Vaselineblur 11550PHOTOPROJECTS

Lightin
g

5Aswell as horizontal smears, I also rotated the filter so as tomake the
smears run diagonally and then vertically – thismade a big difference to the

result. I also tried a variety of smear patterns, such as criss-crossed lines and
wavy lines to seewhat effect it had on the scene. It's worth trying this, as it's
impossible to predict whatworks best.

4Once I'd applied theVaseline across the filter, I fired off a few frames,
choosing a variety of apertures from f/5.6 to f/13, so that I could see how the

results varied (in truth, itmade little difference). After a few frames, I usedmy
finger to applymoreVaseline, to see if a thicker layerwould improve the effect.
However, I found that using toomuch of it led to too soft a result.

Finalimage
My favourite imagewas one taken

towards the end ofmy session. After
refiningmy composition, angling the
camera down towards a smaller area

of the field (tomake the poppies
larger in the frame), I carefully

applied very thin smears to the filter.
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1Having chosen yourminiature subject, the first thing you'll need to do is
find a suitable location. If the buildings are too big or too close, theywill

dwarf your subject, but too small or far away, and theywill be virtually
unidentifiable in the shot, and therefore notworth including at all. Once you
have placed your subject, it's time to assume the shooting position.

2Set your camera to aperture-prioritymode and start with an aperture of
around f/5.6. This should be enough to keepmost of the car in focus, while

blurring the immediate background, from the tarmac to the buildings behind.
Keeping the aperture fairlywidewill blur the area in front of the car too, which
will help to hide any textures thatmay diminish the effect.

Create an illusion ofscale
STEWARTBYWATER:One technique that is quick, easy and
really good fun, is to try and shoot a scalemodel so that, at
first glance, itmight trick the viewer into thinking that it is the
real thing. It doesn't reallymatterwhat you choose as your

miniature object, as long as you set it and shoot it in such away that it
looks in scalewith its surroundings. I decided to shoot amodel car, as I
already have a fewat home. They are also ideal for a quick shoot, as you
don't need to build any sets or scout around for a good location – you
can literally take themout to the street outside your house and shoot
them from the pavement. Just about anymodel car could be used, but
if youwant the result to lookmore realistic, it obviouslymakes sense to
find amodel that iswell-detailed and correctly proportioned. This often
means choosing a largermodel, rather than somethingmatchbox-
sized. This also helpswhen it comes tomaking it look large in the frame.
There are several factors towatch out for, as it is easy to overlook a

small detail in the frame thatmaybetray the true size of your car, such
as large-grainedpavements (it will be obvious that the car is very close
to the surface, and therefore aminiature); traffic bollards and lamp
posts, and other vehicles (whether passing or stationary). Another thing
to be aware of is capturing your own reflection or shadow in the shot.
As youwill be shooting fromvery close to themodel, it's actually quite
difficult to keep these out of the shot. If you are using awide-angle lens
(recommended), youwant to shoot at itsminimum focusing distance.
Althoughnot essential, I'd recommend taking a friend along for this

sort of shot, aswhen shooting fromground level, it is difficult towatch
out for oncoming vehicles andpedestrians. They could also keep an eye
on your kit bag, tomake sure nobodymakes off with it!
Finally, it is worthwearing scruffy clothes for this sort of shot, as you

will inevitably endupgetting dirtywhen you're lying on the ground.

HOODMANRIGHT-ANGLEVIEWER:
If you’re shootingwith your camera at ground-level (or at any
angle fromwhich looking through the viewfinder is
difficult), a right-angle viewer canmake a huge difference.
Not only does itmake composing certain shotsmuch
easier (and thereforemore enjoyable), but it also relieves
strain on the neck, whilst allowing you to keep
your head in amore natural position (and
off the ground). I used theHoodman
right-angle viewer, which is available from
NewproUK for around £99. For further
information, or to see other products
fromHoodman, visit theNewproUK
website at: www.newprouk.co.uk.

Essentialkit

TIMEREQUIRED
20MINUTES
EQUIPMENT
CANONEOS5DWITH
CANON17-40MM
ZOOMHOODMAN
ANGLEVIEWER
ALSO USED
TOYCAR

DEPTH-OF-FIELD: The area in
focus is key tomaking this
picture look believable; toomuch
or too littlewill betray the real
size of themodel anddiminish
the effect. As youwill be shooting
at a very short distance from the
subject, the depth-of-fieldwill be
minimal anyway. If it is too
shallowand toomuchof the car
falls out of focus, the result will
automatically look like amacro
shot. Inversely, this shallow focus
technique canbe used tomake
real-life scenes look likemodels.
If you use too small an aperture,
the depth-of-fieldwill extend
back too far and leave the
surroundings in sharp focus,
exposing the fact that this is only
a very small area you are
photographing. Due to these tiny
margins it is important to bracket
your shots at various apertures,
as youmaynot be able to see
exactlywhere the focus falls off
on the LCDscreen.

Techniquewatch
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3Myfirst attempt, using a 90mmmacro lens, didn't quitework. I took it with
the camera almost resting on the surface of the pavement. Themacro lens

made the car look quite realistic, but the depth-of-fieldwas so shallow (because
I had to shoot so close to the car) that the buildings in the backgroundwere
unidentifiable, so the image had no real sense of scale.

4Anultrawide-angle zoom (in this case aCanon 17-40mm f/4L) givesmore
believable results. Once again, I got down as low as I could, with the camera

virtually resting on the pavement, and shot fromas close to the car as the lens
focuswould allow. I zoomed in slightly tomake the car fill a good portion of the
frame,whilst including a fair amount of background detail to add scale.

If you know that you’re going to be

shooting a subject that will require you

to kneel or lie on the ground, it is worth

wearing some scruffy old clothes or

taking a rug or dustbin liner with you

Wearoldclothes!

Finalimage
Using awide-angle zoomallows

me to fill a large portion of the frame
withmy subject, while including some
of the large houses in the background

to add a sense of scale.While it’s
obvious after close inspection that it’s
amodel car, at first glance it is not so
apparent.When shooting, it is vital to

get down to pavement level. This
‘real-life’ viewpointmakes the car

seem larger than it is, aswhen I shot
fromonly slightly above the car, it

instantly appeared smaller.
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CLONINGTOOL:
TheCloning Tool is one
of themost effective
weapons in the
Photoshop armory.
Users can select how
hard theywant the
cloning brush to be
and also its opacity.
You can even clone
fromseparate images
so, for example, if you
have a portrait where
one of yourmodel’s
eyes is closed, you can
graft them in froman
additional image.

Essentialtool

3The teapot was in the right position, but there
was a problem! The fishing wire couldn't

support the weight of the teapot and snapped.
The solution was to cut a new strip and 'double
up' the wire tomake it much stronger.

1 I started by placingmy boom stand (you could
also use a tripod) into position. Because I was

shooting on a very sunny day, I had to place it to
the right of the frame so that its shadowwas not
visible in the image.

SETTINGUP: I chose to positionmy set-up in the
garden. This is a great location, but remember
that objects that are suspended by the fishing
linesmay swing in the wind, so try and shelter
your props to keep them still.

4Next, I added a cup and spoon to fit in with
the breakfast theme. I found themug kept

falling forward, so used sticky tape to fix the
fishing line to the back of themug so it balanced
in amore natural, upright position.

2Next up, I cut some fishing line from the spool
and wrapped it around the teapot. I then raised

the teapot into its 'floating' position above the
table and tied the other end to the boom stand
using a secure knot.

Nostrings attached!
MATTYGRAHAM: I recently stumbled across a film I had
watched at themovieswhen I was a child:Memoirs Of An
InvisibleMan. It alwaysmademe chucklewhen the star, Chevy
Chase, unwrapped his bandages and all the viewer could see

was a hat, specs and coat 'floating' inmid air. Themovie gotme thinking
of how to recreate a similar effect in a photo.Without Hollywood special
effects, I chose to use thin fishing line and a boomstand to suspendmy
breakfast crockery as if an invisible waiter was serving it up. The trickwith
this technique is to use as fewwires as possible and a solid background
as, when you come to removing thewires in Photoshop, the plainer the
backdrop, the easier it is to clone accurately. You don't have to copymy
idea as the creative possibilities around your own home are endless!

TIMEREQUIRED
45MINUTES
EQUIPMENT NEEDED
CANON EOS 5DWITH
50MM F/1.8 LENS
ALSO USED
FISHING LINE, STICKY
TAPE, BOOMSTAND,
PROPS & TRIPOD
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6With the shot captured, I opened the image in
Photoshop ready to clone out the fishing lines.

I thenmade a duplicate layer (Ctrl&J) to work on
just in case I made amistake and needed to start
over using the original layer.

7 I selected the Cloning Tool and, after zooming
in closer to the image, began to clone out the

lines that were holding upmy props. It's important
to take your timewith this step and clone carefully.
I then flattened and savedmy file.

5I took a test shot and reviewed it onmy LCD
screen. The shot was good, but the background

was cluttered. The solution was to raise the tripod
up to get rid of the brown fence and just include the
grass as the background.

Finalimage
Therewe have it,

breakfast served up by
an invisiblewaiter.

Chevywould be proud!
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Makeyourownlightingmasks

The easiestway tomake amask is to cut it out from
the side of a cardboard box. You’ll need it to be as
large as possible to ensure the light reaching the
subject passes through the openings you cut, rather
than around the side of themask. Tomake this
venetian blindmask, I drew straight lines at regular
intervals, then cut themusing a scalpel and cutting
mat (you can also use scissors) to give a rectangular
maskwith several similarly sized apertures.
It’s important to ensure the edges of the apertures
are cut as smooth and straight as possible as any
major imperfectionsmay showupon the shadows
cast. Once you’vemade yourmask, fix it to a lighting
pole using sellotape. Try to tape it to one section of
the stand, as thismakes it easier to raise and lower
the stand,which you’ll need to do to position the
areas of light and shadowon the subject.

Hardshadow

Softshadow

'Here'soneImadeearlier...':
Creatingyourlightingmask

DANIELLEZANO:Whoever coined the phrase 'the
camera never lies' really didn't have a clue. The
fact is, deception has long been a staple diet of
the photographer, with all sorts of tricks being

employed to fool viewers into believing that an image is
something it isn't. Nowadays, wewould automatically think
of the various post-processing alterations that are possible,
but the truth is that there have always been lots of ways of
faking a scene at the shooting stage. For instance, fitting a
filter to your lens effectively takes the scene one step
further away from reality, as does selecting a very slow
shutter speed to blurmovingwater into amilkymist.
In this photo project, we'll be looking at howmaking

your own cardboardmask to place in front of a studioflash
head can allow you to create a lighting effect that gives the illusion of a venetianwindow
blind. It's a very simple technique to try and the results can look effectivewhen done
properly, adding an air ofmood andmystery to your portraits.

TIMEREQUIRED
ONEHOUR
EQUIPMENT
CANON EOS 550DWITH
CANON EF 17-40MM
F/4L USM LENS
ALSO USED
CARDBOARDMASK,
SCALPEL, ELINCHROM
D-LITE IT KIT &
LIGHTING STAND

HARDANDSOFTSHADOWS: You can vary
howhard or how soft the shadows fall on the
scene by your choice of lighting attachment
and the position of themask. Using a softbox
will give a softer,more indistinct effect, while
using a spill will give amore focused and direct
light that produces a harder shadow. You’ll find
you can also increase the hardness of the
shadows bymoving themask towards the
subject, or soften shadows bymoving it
towards the light. The choice is yours.

Techniquewatch
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3The next shot gave farmore defined lines of
shadows but now the result was too harsh, so

themaskwasmoved away from the subject. Take
carewhenmoving themask, as if the angle changes,
the shadow linesmay becomeuneven.

2Place yourmask between the studioflash head
and the areawhere youwill position your

subject. Take a shot and review the result. In this
shot the shadowswere hardly visible, so themask
wasmoved closer to the subject.

1Work out exposure using a flashmeter
(or by trial and error by changing the aperture

settingwith the camera inmanual and the shutter
speed set to the flash sync).My set-up gave a
exposure of 1/160sec at f/16 (ISO 100).

imageFinalimageFinal
The third position of themask gave

a farmore pleasing result and
I also preferred the composition

with the camera used in landscape
format rather than held upright.
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INKJETPRE-COATS:Although there’s nothing to stop you from
printing photographs on ordinary paper or card, the images usually
end up looking flat and blurry because the ink soaks into the substrate
and spreads out, a bit like ink on blotting paper. Similarly, if you print
on a non-porousmaterial such as plastic ormetal, inkwill stay on the
surface of the substrate and probably be smeared by the printer. To
prevent this, special pre-coats have been developed thatmake both
porous and non-porousmaterials receptive to inkjet inks and allow you
to print high quality images on themwithout falling foul of any of these
problems. It’s a simple concept, but it works brilliantly, and has opened
up all sorts of creative avenues for photographers. OttawaSpeciality
Coatings Corporationwas the first to launch inkjet pre-coats, under the
inkAID label (www.inkaid1.com). You can buy a sample pack of inkAID
pre-coats for £25.95 plus postage, fromArtvango (www.artvango.co.
uk). The kit contains six 118ml bottles of: Clear Semi-Gloss, Clear
Gloss,WhiteMatte, Iridescent Gold, Clear Gloss Type II (with adhesive)
and a separate adhesive pre-coat for usewith theClear Gloss pre-coat.
Each bottle contains enough pre-coat to prepare a dozen ormore
sheets of A4 paper, with two coats on each sheet, so there’smore than
enough to get you going. I found theWhiteMatte andClear Semi-Gloss
pre-coats to be themost useful for photographic printing, so you could
bypass the sample pack and order individual bottles.

Essentialkit

1Thefirst step is to choose your paper. This is
where you can experiment. Try textured art

paper, watercolour paper, handmade paper, coloured
paper, etc. The yellowing endpapers fromold books
alsoworkwell if youwant to create printswith a
distinct vintage look – as long as it will feed through
your printer, it’s worth trying.

2Now it’s time to apply the pre-coats. A clear,
wipe-cleanwork area is required, though any

spills and splashes are easy towipe up. The bottle of
pre-coat should also be given a good shake before
pouring a small quantity into a clean plastic dish.
This can all be done in daylight, as the pre-coats
aren’t light-sensitive.

3To apply the pre-coat, you just paint it on, trying
to avoid getting hairs or other debris trapped in

the emulsion, and alsomaking sure that the
pre-coating is applied evenly. That said, if you
intentionallywant to see brush strokes and texture in
the pre-coat, you can apply a thicker layer and be
more randomwith your strokes.

SETTINGUP: Find yourself a
clear area towork in, away
fromanything expensive, with
plenty of light, so you can see
what you're doing. Put down a
wipe-cleanmat or some
newspaper towork on. You'll
need a bowl to put your
coating solution in, and a
clean, wide brush to apply it
to your paper surface.

Coat your own!
LEE FROST:Back in the days
whenphotographers did it by
hand in the dark (printing that is!),
I enjoyed coating heavy art paper

with a liquid photographic emulsion before
printing black&white images onto it. It was
a fiddly andmessy process (aren’tmost
things done in the dark?) but the results
had awonderful fine-art quality thatmade
the effort worthwhile. Fortunately, you no
longer need adarkroom to experimentwith
hand-coating, because inkjet pre-coats are
nowavailable that allow you tomake awide
range ofmaterials receptive to inkjet inks,
allowing you to go ahead andprint
photographs on them.Paper is an obvious
choice ofmaterial, but if you feelmore
ambitious, and your printer has a flat-feed,
you canprint images on fabrics, wood,
metal and glass. To get you started, we’ll
concentrate on using pre-coats on paper, to
showyounot only howeasy this technique
is, but also howeffective it can be.

TIMEREQUIRED
1HOUR
EQUIPMENT
INKAIDINKJETPRECOATS
EPSONSTYLUSPRO4800
PRINTERBRUSH&PAPER
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4Once thoroughly dry, apply a second coat, ideally
brushing at 90° to the direction of the first coat if

youwant an even finish. Once two coats have been
applied, and each sheet is fully dried, place them
between the pages of a big book, weighed downwith
more books, or any other flat, heavy object, and
leave everything overnight.

5By the nextmorning, the sheetswill be flat and
ready for use. To print on the coated paper, treat

it like normal inkjet paper. The printer settings
requiredwill depend on the printer you use, the
material you’re printing on and your selection of
pre-coat, but I find that ArchivalMatt orWatercolour
Papermedia settingswork fine.

6Allow the inks to dry overnight; then, as a final
step, it is worth considering protecting the

delicate print surfaces by applying two or three
coats of print protection spray. I useHahnemuehle
Protective Spray, but other sprays, such as the
FrogjuiceAerosol fromFotospeed andPermajet
Inkjet Fixativewill do the same job.

If you’re feeling really ambitious, you

could use coatings to createmixed-

media artworks by printing on pages of

text, handwritten letters ormanuscripts,

maps, illustrations or paintings!

Mixedmedia
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3Next, create a text boxwith theHorizontal TypeTool. Use the grid lines as a
guide: try to leave an equal amount of space on two sides of the text box for

framing. Note: It looks better to have at least one grid box space between the
edge of the page and the text. Select the font type, size and colour of your text
and type in themonth, days and dates youwant.

1Having selected your collection of images, the first step is to create a
template, which you can adapt for eachmonth of your calendar. Create a new

file (File>New) and select the size of the paper youwant to print on. In this case,
I’m using 5x7in photo paper and therefore set these dimensions underWidth and
Height,making sureResolution is set at 300. ClickOK.

4Nowcreate a new layer (Layer>New), fill it with a contrasting colour to your
Background Layer and use theMoveTool to resize it. For the best results,

position the box in the opposite third of the page to the text box. Thiswill be the
template for your image box, which you can later adjust to fit the shape of your
photo. Save the document as template.psd.

2Decidewhether youwant a vertical or horizontal format; if horizontal go
to Image>ImageRotation>90CW.Using thePaint Bucket Tool, fill your

Background Layerwith the colour youwant, unless youwant to leave it white.
I found it easier to judgewhere to placemy image and diary dates on the page
once I turned theGrid lines on (View>Show>Grid ).

NewYearCalendar
CAROLINEWILKINSON:
As the endof each year
approaches, we all face
the tricky task of

choosing a calendar that reflects
our taste. Pretty pictures by
photographers pack the shelves
in this seasonal format, butwhy
fork out cash for someone else’s
imageswhen your photographs
could do just as good a job!
Although it’s a greatway to showcase your images, your calendar
will look better if you group your shots into themes such as family,
flowers, wildlife or landscapes. There’s no rule to say you should
stick to the conventional 12-month calendar either: if you’ve got too
many images to pick from,why not do aweekly or, if not enough
images, a bi-monthly calendar. This step-by-step guidewill show
youhow to design a desk-size version fromscratch, but the basic
principle applies for any size of calendar – simply substitute the
5x7in dimensions for anA4, or evenA3, format in step one. If it’s
A4 you’re after, we’ve helpfully provided anA4 calendar template
for you on ourwebsite. You’ll find it atwww.digitalslrphoto.com.

TIMEREQUIRED
30MINUTES
EQUIPMENT NEEDED
IMAGES & PHOTOSHOP
ALSO USED
5X7IN 200GSMMATT
PHOTO PAPER

FINISHINGTOUCH:Youcould either get your calendar
printedat aprofessional printers or do it at homeon
high-quality photographic paper (200gsmormore).
There is noneed toget adesk calendar ring-bound like
youwouldwithbigger calendars (though this canbe
easily doneatmost print stores), a picture standwill do
the job. Youcanbuy small picture stands/easels from
most art stores, and there is a great assortment online
to suit all tastes fromvintageantique to simple
woodeneasels. But for a really cost-effective
alternative, turn aplasticCDcase insideout (so it
standsupright) and slot the sheets of paper behind its
grooves; however, this limits you to a vertical format calendar.

Essentialadvice
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5Open your first image in Photoshop and drag it – using theMoveTool –
on to your calendar document. Then resize the image to fit into the image

box, holding downShift, to keep the image proportionate. If it’s a portrait-format
image use the top and bottomof the (grey) box as the boundary. Use your
judgement here and the grid boxes to frame your photo.

6Click on your photo layer and go to Edit>Stroke and changewidth, colour and
select Outside to create a border. Once you’re happywith the firstmonth's

page, flatten the image (Layer> Flatten Image) and resave the file e.g January.
TIFF. Now, re-open the template file and repeat steps 5 and6 for eachmonth,
remembering to change themonth and dates in the calendar.

Nowyou’refinished.Keepthetemplatefile fornextyearoruse it tocreateaseriesof themedcalendarsasgifts to familyandfriends.Foraprofessional touch,youcouldadd
acover toyourcalendarbyrepeatingthestepsandaddingatitle,but leaveout thedates.Also,whynot trychoosingabackgroundcolour thatcomplementseach image.
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TIMEREQUIRED
15MINUTES
EQUIPMENT NEEDED
NIKOND700
105MMF/2.8 LENS
ALSO USED
PHOTOSHOPCS3

Cross-processing
inPhotoshop

DANIEL LEZANO:Photoshop
has allowedus to create all sorts
ofwonderful effects, butmany
photographerswhogrewup in

the filmage still hanker for someof the
old favourites. The portrait enthusiasts
among youmay remember
cross-processing, which involved
developing a film in the 'wrong' chemistry,
(i.e. running a slide film through
chemicalsmeant for negatives, or developing print films in slide film
chemistry). Thiswould lead to someadventurous and very unusual
results, such as particularly punchy colours or pale and tinted skin
tones in your image. This techniquewas popularwith fashion and
‘lifestyle’ photographers in the ’90s andmanydigital photographers
nowsuccessfullymimic the effect. Cross-processing filmwas always
unpredictable and results varied according to filmbrands andfilm type
– slide films gave very different results to cross-processedprint films.
Outlined here is a simple, yet effective, technique for recreating the

cross-processed look digitally in Photoshop. Itmakes use of theCurves
adjustment, whichmeans you’ll need the full version of Photoshop, or
aCurves plug-in for AdobeElements.

1Choose a portrait image you like, but one you feel would benefit frommore
visual impact. SelectWindow>Layers to reveal the Layers palette. Select the

half white/half black icon that allows you to create a newAdjustment Layer and
choose Curves from the drop-downmenu. Note a new layer called Curves 1
appears above the Background Layer (original image).

2ACurves box appears, which displays a histogram of the image, with a
straight diagonal line running from bottom left (pure black) to top right

(pure highlight). Above the histogram is an option tab called Channel that will
currently read RGB. You’ll use the Channel tab to select the individual
channels in the following order: Red, Blue, then Green.

3Select Red and drag the top right of the curve a little to the left. Then click two
points around a third of the way from the top and bottom and drag them to

create a gentle S curve (i.e. drag the top point slightly to the left and the bottom
point to the right). This gives deeper shadows and brighter highlights in the Red
channel – check the Preview button to see the effect.

4Once you’ve adjusted the Red channel, click on the Channel drop-down
menu and select the Blue channel. Pull the top right end of the curve

downwards to remove some blue from the highlights. When you’ve done this,
pull up the bottom of the curve by nomore than half a square, tomake the
shadows in the blue channel a bit more solid. The line should remain straight.

Original
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Cross-processing films often gave very

unpredictable results, so when you’re

working on the colour channels, don’t be

afraid to experiment with your channel

tweaks to seewhat effects occur

Colourexperiments
olourexperiments

6You should now have an effect that’s reminiscent of a cross-processed film,
withmore solid, bold colours and skin tones taking on a yellow/green tinge.

However, you can also create other adjustment layers to further enhance your
image – in particular the Hue/Saturation and Brightness/Contrast layers, which
can be selected to complete the effect to your liking.

5You can now click on the Channel tab and select Green.With the Green
channel you need to select two points as you did with the Red channel, and

drag them to create another gentle S curve. However, there is no need to drag the
top end of the curve. You can then fine-tune the adjustments to your satisfaction.
Once you are happy with the resulting image, click OK.

Finalimage
Compare this picture to

the original and the effect
speaks for itself: an image
that holds farmore visual
impact thanks to the extra

colour and contrast.

Alternativecross-processingtechnique
While ourmain step-by-stepmimics the effects of cross-processing
print film in slide chemistry,many filmphotographers favoured
experimentingwith processing slide film in print (C-41) chemistry.
This produced extremely high contrast images, with near-bleached
white skin tones, bright red lips and very strong colours. It's a
relatively easy effect tomimic bymaking adjustments to theHue/
Saturation andBrightness/Contrast controls in Photoshop.

1) Open the image and select
Window>Layers to reveal
the Layers palette. Select a
newAdjustment Layer and
chooseHue/Saturation
from the drop-downmenu.
Boost the saturation and
adjust the hue to your liking
(butmake sure that you
don't overdo the effect!).

2)Now select a new
Adjustment Layer for
Brightness/Contrast and
increase the contrast (and
brightness if you sowish).
You'll find that you start to
lose detail in the highlights
and shadows and the colours
become farmore punchy.
Again, don't overdo it.
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3Using the hard grad filter has resulted in amuchmore even exposure,
but there is a problem. The top half of the lighthouse, where the filter has

cut into it, is a bit too dark. The effect is fairly subtle, but it's definitely there,
and doesn't look natural. Fortunately, this commonproblemcan be easily
sorted outwith a spot of post-processingwork.

2With a four-stop difference between the rocks and the sky, I chose a
three-stopNDgrad filter, as it would leave the sky a little bit lighter than the

foreground. The next choicewas to use a soft or hard grad (see panel). Soft grads
aren't always the best choice for seascapes, as the brightest part of the scene is
often across the horizon line, so I decided on a hard grad.

1Arriving at Portland inDorset just before dawn, I took a spotmeter
reading from the foreground rocks and the sky, which revealed a

difference in brightness of around four stops. Although this falls within the
dynamic range of the sensor, shadowdetail has been compromised a little,
and lifting this in post-processing could reveal noise in the image.

TIMEREQUIRED
SHOOTING: 20MINS
PHOTOSHOP: 20MINS
EQUIPMENT NEEDED
CANON EOS 5DMKII,
24-105MM F/4L LENS &
MANFROTTO 055CLB
TRIPOD
ALSO USED
REMOTE RELEASE &
LEE 0.9 NDGRAD FILTER

HARDANDSOFTGRADFILTERS:
Neutral density graduated filters
come in two varieties: hard and soft.
Hard grads have a very obvious and
sudden transition from the dark to
clear areas, whereas soft grads have
amuchmore gradual transition.
Hard grads aremore useful in
situationswhere the horizon line is
fairly straight and doesn’t have any
large objects breaking it. Soft grads
on the other hand are a better option
when you have an uneven horizon.
Also, opt for a hard grad if you intend
to shoot a scenewith a straight
horizon at sunset or sunrise, as the
horizon linewill be the brightest part
of the scene, and soft gradswon’t
hold back enough light.
Sowhat do you dowhen you’re

shooting a scene at sunrise/sunset,
which has a large object such as a
tree or building breaking the
horizon?Here’smyway around this.

Techniquewatch

Control your contrast
MARKBAUER: Oneof themain technical challenges in
landscapephotography is controlling the contrast in a
scene so that you can accurately record detail in both the
land and the sky. Often the sky is a lot brighter than the

land, and the contrast in the scene is beyondwhat the camera's
sensor can record, resulting in either awell-exposed sky and
underexposed foreground, or the opposite. The usualway around
this is to use aNeutral Density (ND) graduated filter. These filters
are brilliantly simple – they are dark at the top and clear at the
bottomandall you do is position the dark half over the brighter
area of the picture, reducing the contrast between the light and
dark areas and therefore enabling you to capture detail in both the
foreground and the sky. The only problem is that the dividing line
between the dark and light areas of anNDgrad is a straight line,
and not all landscapes have a straight horizon – often the horizon
is brokenby an object such as a tree, a hill or a building, and the
filter can cause an unnatural-looking darkening of the top of these
objects. However, help is at hand as,most of the time,
post-processingwill rescue the shot. Here I explain how to use an
NDGrad and remove its effect fromspecific areas.
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Curves and Levels, but for this selection I decided to use theDodgeTool,
as I could paint the effect on gradually and build it up in the areas that
needed itmore. I set the Exposure value to 10%,which enabledme towork
gradually on lightening the selection.

4Using theMagnetic Lasso Tool in Photoshop, I selected the darker top
half of the lighthouse, so that I couldwork on the problemareawithout

affecting any other part of the image. I decided not to apply any feathering to
the selection, as this could leave a 'halo' around the lighthouse once I'd
finished lightening the selection.

Finalimage
This is the final result,

which has good detail and
colour in both the sky and
foreground, and a natural-
looking lighthouse with no
darker section at the top.
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5Hold Alt and click between the second and third layer. Now select the
Brush Tool and hit X to choose a white foreground colour and paint over

the skin area. Create another Solid colour adjustment layer, choose a second
colour, clip the layer below and repeat for each colour.

6Select the Crop Tool and hold down Shift while dragging from top left to
bottom right to create a square image. Move the square until you’re

happy with the crop. Double click to complete. Select all layers except the
Background Layer by holding Shift and clicking on each layer.

1Open the image
and drag the

Background Layer
onto the new layer
icon to duplicate the
layer. Now add a new
coloured layer
between the two
layers by clicking
Layer>New Layer,
then Edit>Fill Layer
and pick a colour.
Drag this layer
between the two and
click the top layer.

2Use the
MagicWand

Tool to select the
background and hit
delete to show the
coloured background
behind. Go to
Select>Deselect,
then Image>
Adjustments>
Desaturate and
Image>Adjustments>
Threshold, adjusting
the slider to retain
facial details.

Giveyourimagea1950'sstyleappeal!
CAROLINEWILKINSON:When someone says
AndyWarhol, probably one of the first images to
pop into their head is a colourfulmontage of
MarilynMonroe or aCampbell’s soup can.

Warhol is one of themost recognised artists of the 1950’s
pop artmovement andwe’re still replicating his style 60
years later, with a lotmore ease since the introduction of
Photoshop.When it comes to picking an image for a
Photoshoppedpop art image, it’s best to pick a shotwith good contrast because you’ll be,
in effect, using the shadows as a black outline for your colours, andwithout good shadow
detail to define the face, your subjectmay look like they’rewithout a nose ormouth. If
you’re unsure, check the imageby turning it black&white and then clicking
Image>Adjustment>Threshold to playwith the slider to judge if enoughdetail is retained.
You should also try to pick an imagewith a background that contrastswith the subject to
make it easier to extractwith theMagicWandTool. Some shotswork better than others,
but it’s a case of trial and error. Sowhat are youwaiting for, give your shots a new lease of
lifewith this graphic Photoshop technique.

3Add a touch of
blur by going to

Filter>Blur>
Gaussian Blur and
setting the slider to
1px. Drag the top
layer onto the New
Layer icon to
duplicate. Select the
Paint Bucket Tool and
hit X to select a white
foreground and click
the face. (X changes
the foreground colour
from black to white).

4Select the top
layer’s blending

mode toMultiply.
Click the second
layer and create a
Solid adjustment
layer (the split circle
icon on the Layers
palette). Choose a
colour to use as a
skin tone, then select
the Paint Bucket
Tool, hit X, and fill the
layer with black to
mask the colour.

TIMEREQUIRED
15MINUTES
EQUIPMENT
ADOBEPHOTOSHOPCS4

BEAWANDWIZARD! If you struggle
selecting thewhole background,
increase or decrease the Tolerance level
of yourwand slightly and hold Shift while
makingmultiple selections.

Essentialtool
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7Hit Cmd+T to
enter Free

Transform. In the
options at the top,
change the
percentages to
50% for width and
height, andmove
the image to the top
left of the picture.
Select theMove
Tool, hold Alt, drag
the shot to the top
right, making a
copy of the image.
Repeat three times
and position the
boxes on the page.

8To change the
background

colours, scroll
down the Layers
palette to select
the right layer,
then choose a
colour and use the
Paint Bucket Tool
on the square. For
other features you
want to change the
colour of, double
click on the
corresponding
layer’s coloured
box to bring up the
colour picker.
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7Elements users don’t have the luxury of
blending options sowe need to useVariations.

Go toEnhance>Adjust Color>Color Variations.
Now select Shadows on the left to start and click
the relevant picture button to add the colour of your
choice to the shadows.

8Click asmany times as you need to get the
desired strength, and don’t be afraid tomix

colour tones to get the right effect. Use the
subtract picture button if you go too far. Check the
Highlight buttonwhen you’re done and repeat for
the highlight tones. ClickOK to finish.

6Change the layer blendingmode fromNormal
to Color andmove theHue slider to choose

your highlight colour. Click Layer>Layer
Style>BlendingOptions and split the black
triangle. Set the right side to 155 and the left to 80.
ClickOK to finish thePhotoshopwork.

Basic skills for duotones
MATTHENRY:Duotoning, otherwise knownas
split-toning, dates back to the days of the
chemical darkroom, butwith digital processing,
separately toning shadows andhighlights has

becomemuchquicker and easier on thewallet. The
treatment suits imageswith good tonal range; clear
distinction between the shadows andhighlights, so that
the colours don’t overlap. There are somany colour
combinations you can try: red and yellowworkwell, as do green andblue, but the effect can
also be changeddepending onwhich colour you use for highlights andwhich youuse for
shadows. For instance, red highlights andblue shadows give a contemporary, energising
look, while red shadows andblue highlights can bemore unsettling. There are no hard and
fast rules though– keepmixing it up until you hit on something you like.

5Now, drag the left-hand part of the triangle
along to the 100 setting and the right-hand

part to 175. If you now click thePreviewbox on
and off you can see how the highlight tones have
been excluded from the toning. ClickOK then
add anotherHue/Saturation adjustment layer,
checking theColorize box again.

3Once the image is converted to black &
white, in Photoshop, add a Hue/Saturation

adjustment layer and check the box that says
Colorize. Before we go any further, change the
layer‘s blendingmode fromNormal to Color
using the drop-downmenu to prevent the image
being lightened or darkened.

4Drag theHue slider to establish the colour
wash you’d like for the shadows. Ignore the

fact that the colour is applied to thewhole tonal
range for now. Select theHue/Saturation layer
and select Layer>Layer Style>BlendingOptions.
HoldAlt and click thewhite triangle on the This
Layer slider to split it into two parts.

1Thefirst thing to
do is convert our

image tomono.
Elements users
should duplicate the
Background Layer
with Ctrl/Cmd+J and
runEnhance>Convert
to Black&White.
Photoshop users
should add aBlack&
White adjustment
layer using the button
at the layer palette
base (or Layer>New
Adjustment Layer).

2 In both Adobe
Elements and

Photoshop, you have
the option to choose
one of the presets
(use the drop-down
menu in Photoshop)
or work with the
colour sliders to
produce the desired
effect. Experiment
freely with each
method until you
reach a look that
suits the particular
image in hand.

TIMEREQUIRED
15MINUTES
EQUIPMENT
ADOBEPHOTOSHOPCS4

TOBLENDORNOTTOBLEND?
Although there are differentways to achieve
the duotone effect in Photoshop, Blending
Options offer by far themost control over
results. You canbe selective, using the
sliders to specifywhich tones receive the
colourwash and those that don’t:making it
easier to keep colours separate as is often
the dangerwith other techniques. Blending
Options aren’t accessible for Elements users
but excellent results can still be achieved
usingColor Variations and selecting
shadows andhighlights separately.

Techniquewatch
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Finalimage
As you can see, the
Photoshop treatment has
given the former black
&white image a newand
appealing atmosphere.
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5Each Blend Option has a range of BlendModes to experiment with. I was
tempted to use Soft Light as it boosted the bride’s glow and contrast, but in

the end I opted for the Normal setting as it offered a less stark result withmore
natural skin tones, which suitedmy image better.

2 I made a second layer (Layer>New>Layer) and, with the Paint Bucket
Tool, coloured it black. I brought the opacity of the layer down to 56% so

as to see the image underneath and, using the Clear brushmode and opacity
of 62%, started to erase areas I wanted to reveal.

3 It’s worth playing aroundwith the different brushmodes, sizes and
opacities to get the desired effect. I found that 62%was too harsh to get a

smooth finish and I got a better result with the layer’s opacity at 100%and by
varying the brush opacity between 9 and 17%.

4Once I was happy with the detail I’d brought forward, I felt that the
graduation between the bride’s profile and the black fill layer needed to be

smoother, so I played with the different blending options (Layer>Layer Style).
The Satin blend gaveme the smoothest finish.

1 I tried to blur the background bymasking off the bride and applying the
maximum lens blur to the background by using Filter>Blur>Lens Blur and

setting the Radius to 100%. I wanted a simple image that focused on the bride
and lighting; this technique didn't do that.

CAROLINEWILKINSON:
When shooting a portrait
there is a lot we can do to
control key elements such as

poses, lighting and composition. But
there are alsomany instances when
you can’t control it all. For example,
this bridal portrait had great lighting
coming from thewindowbut the backdropwas cluttered and
distracting – ruining the photograph.Often, you can addblur in
Photoshop to recreate a shallowdepth-of-field, softening the imposing
background. But in this case, it’s not enough and for this picture to be a
success the backdrop needs to be simplified. Using a coloured layer to
mask the background is an effectiveway of transformingmost images
that have great light but amessy backdrop. If you have imageswith a
similar problem, then give this technique a try!

Addanartisticedge
TIMEREQUIRED
30MINUTES
EQUIPMENT NEEDED
PHOTOSHOPCS3

Brushes&layers!
This technique requires you to create anew ‘black’ layer anduse thePaint
BrushTool to remove the colour and reveal the imageunderneath. A fair
amount of trial anderror is needed toget aneven result, but oneway is to
keepa softmedium-sized, very low-opacity brushmovingandgradually
strip away the colour. If youdomakeamistake, change thebrushMode to
Darkenandgoover the areaswhere theopacity is too thin.
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Pick a subject that has a good tonal
range and concentrate on bringing the

opacity of the highlights back to 100%,

especially thewhites of eyes, so you
create an image high in contrast

Keepitsimple
eepitsimple

Finalimage
Youmayfind that adding a

blending option boosts
the shadows, so it’s worth

going back over areas of the
subjectwith a lowopacity

brush to recover the details.
Tomake this image even
simpler, I added a black&

white adjustment layer
(Adjustments>Black&White)

and using theDarken brush
mode, I went over areas of the
black layerwhere the opacity

had been reduced.

OriginalwithLensBlur
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FindingLayerBlendModes
While youcango toLayer>LayerStyle>BlendingOptions
andfind theBlendModedrop-downmenuunderGeneral
Blending, alongwithmanyother advancedoptions that
will look very confusing
to youat this stage,
there’s amuchquicker
way.All theblend
modescanbe foundon
adrop-down list in the
top-left corner of the
Layerspalette,whichby
defaultwill haveNormal
blendmodeselected.

1You need at least two layers for this technique to work, as a blend
mode determines how a top layer interacts with the layer underneath

it. So, to begin with, I duplicate the Background Layer, by clicking the
layer and choosing Layer>Duplicate Layer orCtrl+J.

3I need to separate the contrast and saturation, so sticking with
Overlay and at opacity 100%, I take the colour out of the top layer

using the command Image>Adjustments>Desaturate. It’s givenme the
boost in contrast I want andmuted the colours. I like it!

2I want to boost the contrast, so I run through the list of blendmodes
and finally opt for Overlay, as it darkens the blacks and lightens the

highlights. If the effect is too strong, try reducing the top layer's opacity. By
boosting the contrast, however, I've oversaturated the face, making it red.

4Bydesaturing the shot, I've lost the colour in the eye. To give it back its
impact, I have used aQuickMask and small brush to select the eye on the

Background Layer. Click theQuickMask icon again to revealmarching ants.
I then boost the colour (Image>Adjustments>Hue/Saturation).

Boost contrast with blending modes
CAROLINEWILKINSON:
Manipulating contrast and
colour saturation iswhat
AdobePhotoshop excels at,

but these twoproperties are often
interlinked. Boost an image’s contrast
and you’ll notice the coloursmay
look oversaturated too.While adjusting
the Levels or Curves is themost
commonway to change contrast and theHue/Saturation tool for
adjusting colour, using blendingmodes in amulti-layered image
canbequicker and give youmore creative flexibility.
Put simply, blendingmodes determine howa top layer interacts, or

‘blends’ with the layer underneath. There are 25blendingmodes to
pick from, each having a different effect, but there is also a group
dedicated to changing contrast, includingSoft Light, Hard Light, Linear
Light, HardMix and, one of themost used,Overlay. Each one handles
light anddark differently – so it’sworth experimenting – and it'sworth
noting that you can add them to any layer: a duplicate layer, an
adjustment layer, a fill layer or a different image layer.
If you are new toworkingwithmultiple layers andblendingmodes,

don’t be daunted, thismay sound advancedbut it’s not. In fact, this
tutorial could be the encouragement you need to start using layers in
all of your Photoshop andElements editing. Let’s see how it’s done.

TIMEREQUIRED
TENMINUTES
EQUIPMENT NEEDED
ADOBEPHOTOSHOP
ORELEMENTS
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Overlay is a combination ofMultiply

and Screen blendmodes. Use them

separately to darken or lighten images,

respectively. Great if you’re dealing

with over or underexposed photos

QuickfixQuickfix

Finalimage
Overall, I’m happywith the final
image, but thought it was a bit
soft, so I added aHighPass filter
to boost the detail. I did this by
duplicating theBackground Layer
again, andmaking it the top layer,
then adding aHighPass filter
(Filter>Other>HighPass) set to 5
pixels and selecting the blending
mode toOverlay. Experimentwith
different filters and blending
modes for various creative effects.

Original
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1To check the
model's head

is straight, select
theCrop tool from
the tools palette,
click and drag to
create a box, then
line up the edge of
the boxwith the
line of the nose
and the centre of
the lips. If this
line isn’t straight,
click and drag
outside of the box
to rotate until it
is. Nowexpand
the edges of the
Crop to fit the
rest of the image
in and double
click inside the
box to accept.

3On your
Layers palette

click the eye
symbol on the
background, this
should just leave
Layer 1 showing.
Click on Layer 1
so it is selected,
and hit Ctrl+J
oncemore to
create a second
copy of the layer.
This will show in
the layers palette
as Layer 1 Copy.
Now go to Image>
Rotate>Flip Layer
Horizontal to
create themirror
imagewhich will
create the other
half of the face.

2Now your
image is

straight, select
the Rectangular
Marquee tool
from the tools
palette and
(depending on
which side of the
face youwant to
use) click and
drag from the top
left or top right
corner, down to
the bottom centre,
so the edge of the
selection goes
through the centre
of the nose and
lips. Now press
Ctrl+J to paste the
selection into a
duplicate layer.

4Make sure
you have your

new top layer
selected in the
layers palette.
Now select the
Move tool from
the tools palette,
then click and
drag the layer to
align it with the
other half of the
face. Check that it
lines up correctly
by zooming in on
details around the
lips or nose and
fine-tuning them.
Once you’re
happy, hit Ctrl+E
to 'Merge down',
combining it with
the layer below.

Create a fun 'face-flip'
MATGALLAGHER: It is often thought that themore
symmetrical your face is, themore pleasing or
beautiful you appear. This iswhy you’ll find that
mostmodels andfilmstars have very symmetrical

features.Most of us however, aren’t blessedwithmirror
perfect symmetry butwith the help of a little Photoshop
work, we can seewhatwe’d look like if wewere. This
technique is in essence, the digital equivalent to standing at
right angles tomirrored glass in a hall ofmirrors, as it
duplicates one side of your face onto the other and can have
some very bizarre effects. The first stage is to take a photo
of your subject, or of yourself if youwant to flip a
self-portrait. For best results, ensure that the lighting is even
across the face, and not just coming in fromone side.Make
sure that you shoot the face straight on and froma level
height, as any kind of anglewill distort the effect. If however,
youwant to create somemorewhacky effects, ignore these
guidelines andhave some fun!
Formy image, I used a studio shot that I’d taken earlier in

theweek. It was taken against awhite background and
straight on to the camera, thusmaking the process easy. It’s
best to do any alterations and cloningwork to the face
before youdo themirror flip, as any imperfectionswill
appear twice once you’ve flipped it. TheHealingBrush toolmakes this quick and easy, while the
Paintbrush tool on a lowopacity andflow,with a sampled colour, can be used over larger areas.
One of the great things about this technique is that, even on a seemingly even face, you can endup

with two very different-looking images from the left and right sides. You can thenpick the version you
prefer or place themnext to each other to show the difference. After a quick trial run, I choose to use
the left-hand-side ofmymodel’s face as it gave a nicer result. If the image is pretty straight to start with
and sliced in carefully, the joining process should be hassle-freewith little adjustment needed. The
main areas towatch though are the hairline and the neck – youmayget a light or dark line along the
'seam' too but this can be easily removedwith somecareful cloning or healing brushwork.

Original

TIMEREQUIRED
1 HOUR 15MINUTES
EQUIPMENT USED
ADOBE ELEMENTS
ALSO USED
SYMMETRICAL PORTRAIT

PHOTOEDITINGSOFTWARE:
Though youmay aspire to have
the very latest version of Adobe
PhotoshopCS for your image
editing, you can still achieve
some impressive results with
moremodest software
packages. The basic
adjustment tools that you need
to tweak your images haven’t
changed thatmuch over the
years, and this tutorial along
withmany otherswewill cover
in themag can be followedwith
just about any photo editing
software.We have usedAdobe
Elements 4.0 to create the
images and screen grabs here,
to show just how simple it is. If
you don’t currently have any
photo editing software, or are
looking to upgrade your current
software, we recommend you
look at Adobe Elements 9,
which offers plenty of features
at an affordable price.

Essentialkit
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here, though hair and neck-linesmay need some extra attention. Select the
HealingBrush from the tools palette, then holdAlt andClick to select a sample
point froma smooth area of skin, then paint over problemareaswith small
strokes, using a small tomedium-sized, soft edged brush.

6Work yourway down the seam to remove the light or dark strip that often
occurs along the joint. Be patientwith the neckline, as shadows cast by the

chin and longer hair can prove problematic. Once you are happy, save your
image under a newname, then try using the same technique for the other side
of the face tomake a set, or create a flip-face of each familymember.

FINALIMAGE: Evenwith quite a symmetrical face, the results from the left and right sides can look like two
different people. As you can see, unless themodel has a symmetrical hair line, this canmake a big difference too.

For the best looking finished image,

make sure the lighting is even and

the head is pointing straight at the

camera. If, however, youwant to create

somethingmore obscure, try raising or

dipping the head and altering the light

Serious...orjustforfun?

erious...orjustforfun?
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PHOTOSHOP’SBLURFILTERS:
You can find several different filters in the Blur
section, but themost popular are Lens,Motion
andGaussian blur. These tools can be used to
smooth skin in a portrait, addmotion to a static
subject, eliminate dust or fluff, soften print texture
or give a shallow depth-of-field effect.

Techniquewatch

6Click Ctrl+D to remove the ‘marching ants’
and you're ready to adjust the saturation. Go

to Image>Adjustments>Hue/Saturation, or click
(Ctrl+U) to bring up the Saturation option.

8Select curves (Ctrl+M) andmove the curve line
into a small S-shape. Be careful not to overdo

this function as itmay spoil your image. Save your
image (File>Save).

7You need to boost the Saturation by dragging
themiddle slider to the right. This step is down

to personal taste, butwe’d recommend changing the
amount to around+40.

1Open your image in Photoshop and select
theQuickMaskMode, which is a circle icon on

your Tools palette. If you can’t find it, just press Q
on your keyboard instead.

5 It’s time to apply the all-important blur to the
image now. Click on Filter>Blur>LensBlur and

youwill now see the effect applied to your image in
a previewpanel. Tweak the blur options until you’re
happy and then clickOK!

3 If you don't haveQuickMaskMode, choose the
Gradient tool option by either pressingGon your

keyboard, or selecting it fromyour Tools palette. As
before, draw your line across the screenwhere you
want the image to remain sharp.

4You should now seewhere you’ve applied
yourmask area. If it isn’t right, just go back

and repeat the last step. If you’re happywith you
mask area, pressQ. Themask areawill nowbe
surrounded by ‘marching ants’.

2Select theBrush Tool fromyour Tools palette.
Drawa horizontal line across the screen,

covering the area youwant to remain sharp in the
image. Use a soft brush at 85%opacity.

It’s toy town time!
MATTYGRAHAM:Howdo you turn a city
scene into a toy town? This increasingly
fashionable style of photography, using
shallow depth-of-field, selective focusing and

saturated colours, is known as ‘tilt shift’ and is
normally achieved through the use of dedicated lenses,
but we’re going to show you how to create the effect for yourself in Photoshop.Miniature
scenes are usually viewed from above, whichmeans thatminiature photographyworks
best on images shot from a high vantage point, like a bridge or building. Thanks to a
combination of selective blur and saturation, you can bring a standard shot to life, and
make it appearmore like a child’s playset. If you’re new to Photoshop, it may take some
trial and error to get the effect right, but once you do, you’ll be addicted!

Original

TIMEREQUIRED
20MINUTES
EQUIPMENT NEEDED
PHOTOSHOP (CS3+)
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2Open the first image in themontage and
increase the size of the canvas so it’s big enough

to add all other images in the set.Mymontagewill
be three imageswide by six deep, so 80x110cm
should beOK. You can alwaysmake the canvas
bigger at a later stage, or crop any excess canvas.
I placedmyfirst image in the top left corner.

1Process theRawfiles thenmake JPEGcopies of
your selected images. Using the JPEG format

reduces the size of each image so thatwhen you
combine a dozen ormore of them the resulting file
size doesn’tmake your computer blow a gasket! I
also reduced the image size so each imagewas
25cmwide at 300dpi.

5With all images in place, crop any excess canvas
then go to Layer>Flatten Image tomerge the

layers. Add a border by extending the canvas using
Image>Canvas Size and increasing it evenly on all
four sides. Select Image>Canvas again but only
extend the bottomedge so that you can add text.

3Double click your second image, then using
theMove Tool in Photoshop, drag and drop

the image onto the enlarged canvas. You can use
theMove Tool to position the image next to the
first one and the ArrowKeys to then fine-tune
the position of the image. I chose to leave a gap
between each image.

6Click on the TypeTool icon in Photoshop then
drag the cursor across the bottomborder of the

poster to create a text box. Next, add a title and your
name, then experimentwith different type sizes and
typefaces until you’re happy. Finally, choose the
colour of the text if you don’t want plain black.

4Repeat step three, dragging, dropping and
positioning each image on the canvas. If you

need tomake changes to any of the images, open
the Layers (Windows>Layers), click on the
appropriate layer and dowhat needs to be done.
Remember to save themontage as you go.

GETTINGTHESHOTS: To photograph images for this poster project, I used one camera and
one lens –my trusty 24-70mmstandard zoom,which has a decent close-focusing capability.
Although I normally use a tripod for just about every shot, on this occasion I wanted to be able
tomove around quickly and freely, so I decided to shoot handheld. As theweatherwas dull and
light levels relatively low compared to a sunny day, I increased the ISO to 400 in order to
maintain a reasonably fast shutter speed and prevent camera shake.

Pickacolour,createaposter!
LEEFROST:
While leading a
photo
workshopon

theNorthumberland
coast recently,my group
and I had to face the
inevitable dull day that’s
par for the coursewhen
shooting landscapes in
theUK. Luckily, wewere
on theHoly Island of Lindisfarne, which is packedwith
details that suit the soft light created by overcast
weather, so I set everyone the task of seeking out and
shooting details in the fishermen's huts, old boats,
lobster pots andpiles of fish crates. No individual shot
would be amasterpiece, but as a set of images they
would gain collective visual strength. To prove this, I
started shooting details in the steel hull of a yacht that
hadbeenpainted bright blue. I then started looking for
other blue subjects scattered around the harbour and
before I knew it, I’d created an eye-catching set of
themed images. Back home, Rawfiles processed, all I
had to dowas decidewhat to dowith themand the
idea of a colourful poster came tomind. Here’s a
step-by-step to how I created it.

TIMEREQUIRED
TWOHOURS
EQUIPMENT NEEDED
CANON EOS-1DSMkIII,
24-70MMZOOM
ALSO USED
PHOTOSHOP CS3
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Headoutsidedayornight
15greatoutdoorprojects, ranging fromnature

and landscapestoshootingtraffictrails

Takestunningshotsindoors
Yourhomeisan idealplacetocaptureavariety
ofbrilliant images, fromstill-lifes toportraits

Gettogripswithlighting
Aselectionof techniquesto tryusingflashguns,
studioflashandmoreunusual lightsources

Expandyourcreativeskills
Ourselectionof imaginativeprojectswillhelp

developyour imaginationaswellasphotoskills

Photoshopperfection!
Addstunningeffects inpost-productionwith
easethanksoursimplestep-by-stepguides

Improveyourportraits
Whetheryou’reusingdaylight,flashor

studioflash,we’ve lotsof techniquesto try!
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